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 ViewMate Release Notes 

New Features 

11.24.50 

• Mirrored View 

“View > Mirrored on X” will toggle the mirrored view mode. 

The loaded data will not mirrored only the view. 

11.24.36 

• New in the D Codes Setup Table (F5) 

- Changing Shape of D Codes While Preserving Dimensions: when selecting more than one D Code and 

changing the shape, the dimensions of the D Codes selected will be preserved. 

This is useful, as an example, when changing a number of Q shapes to R shapes. 

- A new command to change all diamond shapes to rotated squares, preserving geometry: “Operations > 

Convert D to S”. 

11.24.30 

• Copy Coordinates to Clipboard 

New item in the context menu (right-click). Allows the current coorinates to be copied into another document if 

needed (such as Excel). 

• Combine the Data from Several Layers into One 

In the Layers Setup dialog (F10), select several layers, then right click and pick “Conbine Selected”. This will 

move all the data into the first layer in the selection. The remaining layers will be empty. 

11.24.27 

• Import ODB++ 

Component info, if present, is also tranferred to CPU/CPL pads. 

Support for “oblong_ths” shape. 

• Import IPC-2581 

Support for slots (“SlotCavity”). 

• View Drill Stack Up 

“View > Info > Drill Stack Up”. 

Shows in a text dialog the drill layers stackup relative to the circuit layers. Layer types must be set. 

• View D Code and Tool Codes Used In Certain Layers 

Two new commands “Setup > D Codes in Layers” and “Setup > Tool Codes in Layers”. 

• Exclude Import of ODB++ Component Layers 

“File > Import > ODB++ Options > Exclude COMPONENT Type Layers”. 

Component layers render more slowly and, when not otherwise needed, one can exclude from import. 
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11.24.15 

• Support for Gerber Extended AperFunction Directive 

This directive associates a D Code (aperture) with a function. 

An exmaple is: %TA.AperFunction,ViaPad*% 

The function names are in the Gerber spec. 

The D Codes Setup table (F5) has an addional column for this, called “Function”. A blank value means there is no 

function specified. 

Currently the function field is only used for import and export, no special meaning for CAM internal oprations. 

• Insert Empty Layer 

In the Layers Toolbar context menu a new command: “Insert Empty Layer” will insert an empty layer before the 

current one and shift the current and all following down to make room. 

• D Code Usage Per Layer 

The “Layers” command in the D Code table now shows layers used for individual D Codes in the group of 

selected D Codes. 

• D Code Info in CSV Format 

In the D Code Setup table “Operations > Export as CSV File” will create a file that can be opened in Excel. 

• New Edge To Edge Distance Tool 

“View > Distance > Edge To Edge Distance Tool” displays the distance between the edges of two elements. 

11.24.2 

• Copy By Displacement 

“Edit > Edit Selection > Copy By Displacement“. 

Works the same as “Move By Displacement” but does a copy instead of a move. 

• Change Coordinate of a Selected Pad or Linear Trace 

“Edit > Edit Selection > Change Coordinates“. 

• New Release of EMS Magician (V1.2.1) 

 

- Enable back button on every step without restrictions 

- Update Help Files 

- PCB Analyzer - Update "First" button behavior 

- Bug: Layers deleted when we switched to panelize module if the PCB Analyzer has not finalized all the steps. 

- Bug: On some rare occasions when the StartOver button was pressed there were temporary layers that remain 

active in viewmate 

- Bug: Whenever button was clicked it load the Original temporary file saved by EMS instead of the loaded on 

viewmate. 

- Bug: PCB Analyzer - Clip to board outline panel was not clearing after start over event 

- Bug: PCB Analyzer - Identify layers was not updating the layers if DFA Settings changed after reordering 

layers 

-Bug:  If for some reason AppData files are removed the application crash on launch 

 

• Render Drill and Rout Layers as Scratch 

“Setup > Render Drill Layers as Scratch“. 
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If checked, will cause the drill and rout layers to render as scratch over all the other layers. 

 

Normal rendering: 

 
 

Scratch rendering: 

 

• Layer Type in Layers Toolbar 

Display can not be controlled with “Setup > Preferences > Show Layer Type In Layers Toolbar”. 

• Select By DCode 

Now has add and remove operations, like the other selection tools. 

• Convert to Positive Operation 

Has been improved. 

11.22.32 

• Insert Edge to Edge Dimension 

“Insert > Edge to Edge Dimension”. This operation is similar to “View > Distance > Edge To Edge Measurment 

Tool”. It is a tool that allows you to click on two elements and inserts edge ot edge markup into an empty layer. 

You need to setup using “Insert > Loc and Dim Setup” as below: 
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Text height and font can be anything you like. 

When picking elements, start with the righmost one in order to have the text orient correctly. 

11.22.10 

• D Codes Table – Rounding Values 

Additional rounding option added. 

11.22.1 

• Rotated D Codes 

D Codes can now be rotated. 

The Setup D Codes dialog now shows an “Angle” that can be set. 
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You can set this angle by double clicking on the cell, or selecting any number of D Codes and doing “Operations > 

Rotate”. 

 
 

When saving a .bin file, rotated D Codes are converted to custom (M) shapes, to make the output backward 

compatible with previous versions of the CAM software. When opening these files in the current version, the 

customs will be converted to rotated built-in shapes. 

One can also convert selected rotated D Codes to custom (M). 
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• New built-in D Code Shape 

“Bullet“ (single character designator “L”). Also known as hal-obround. Same as the obround shape (O), but with 

only one rounded end (to the right). Other orientations can be achieved using the “Angle” feature (see above). 

 

 

• Select by Range of Values 

“Select > Special > Pads in Size Range“ and “Select > Special > Area Range” 

Selects elements with size values in a range of two values. 

11.20.29 

• Insert Rotated Rectangle 

“Insert > Rectangle“. 

If Shift is pressed when picking the first corner, the user will be asked to click on 2 more corners. These will define 

a possibly rotated rectangle. 

11.20.22 

• Setup > Save Parameters to File 

Saves the parameter values of some of the commands. These can be restored later from the saved file. 

A preliminary set of parameters are now saved. More will be added later. 

• View > Selection > D Codes 

In visible layers only. 
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• Select Drill Holes and Routing Paths 

“Select > Drill And Rout”. Use this to select elements of chosen tool numbers in a set of layers. 

The command works on visible layers only. So, to restrict selection to certain layers turn off the others. 

Tools numbers can be picked from the dialog that is displayed. 

• Last Used Option for Transcode D Code Dialog 

Allows quick usage for the last D Code used for transcoding. 

11.20.16 

• Import ODB++ 

Better handling of complex jobs. 

• New Layer Visibility Action 

For the layers toolbar. The new action is Ctrl+Shift+Double-click. This will make visible ONLY the range of layers 

between the previous active layer and the layer double-clicked. 

This is in addition to the previously available actions: 

- Double-click: toggle visibility of current layer 

- Shift+Double-click: make visible range 

- Ctrl+Double-click: turn range visibility off 

• Optional Tolerance Text 

In “Insert > Loc and Dim Setup”. If tolerance text is entered it will be added to the dimension text. 

11.20.7 

• Insert Barcode 

“Insert > Text” now has a number of barcode “fonts”. Their name includes (Barcode). 

The only relevant items for inserting a barcode are “Height” and “Aspect Ratio”. For barcode types that are 

square (like QRCode), “Aspect Ratio” will be ignored and “Height” will be the size of the generated barcode. For 

the others height will be given by “Height” and width by “Aspect Ratio” X “Height”. 

• New Clipping Operation 

“Edit > Break Using Line”. Similar to “Break Traces and Clip Polygons”, but uses a line segment to break instead 

of a frame. For polygons, the line segment needs to completely cross the polygon (cannot start from inside the 

polygon). 

11.20.4 

• Layer Organizer 

Now supports up to 24 layers, 

• Select Text Based on Content 

“Select > Special > Text”. This will select all text blocks that match the regular expression you enter. 

It uses regex, which is a bit more complicated than regular text, but allows for flexible searches. 

You will need to lean just a few patterns. For instance: 

- ABC will match all the text blocks that are exactly ABC 

- ABC.* will match all text blocks that start with ABC. The dot character in regex matches any character and star 

means one or more. 

- .*ABC.* will match all text blocks that contain ABC anywhere. 

Be careful when you want to match an actual dot or star or any other character that has meaning to regex. In cases 
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like these you need to escape the character with a backslash. 

For instance ABC\. will match all blocks that are exactly “ABC.”. 

There are many regex tutorial on the web, 

11.20.1 

• Import IPC-2581 

Files in IPC-2581 format can now be imported. 

• Zoom on Selection 

“View > Zoom > On Selection” or “Ctrl + Shift + Home”. 

• Import Gerber X2 

Component and net info was imported incorrectly. 

• View > Selection > D Codes 

Only one D Code of the same size was shown. Same for View > Selection > Tool Codes 

11.18.49 

• New Component Operations 

“Component > Select”. Can select/deselect CAM components and pads with component info. 

“Component > Add Component Info to Pads” can be used to add component info from component layers (CMU 

and CML) to the corresponding layers with pads: copper, soldermask and solderpaste (CPU/CPL, SMU/SML, 

SPU/SPL). Only visible layers will be processed. 

• Support for Gerber X2 Component Info 

Support for “TO.C” (reference designator) and “TO.P” (pin name)”. 

• Shortcut for “Go > Center of Selection” 

Ctrl+Shift+K. 

• “Go > Coordinates” improvement 

One can now type arithmetic operation in the X and Y boxes. For instance: “10.2+0.25” or “230.1 / 1.25”. 

Only two terms allowed an no units in this case. 

11.18.44 

• Converting Pad Patterns to Components 

The “Components” menu has new items: “Convert Footprints to Components”, “Change Reference Designator 

Tool” and “Change Orientation Tool”. 

To see how to use this feature read the document “Convert Pads to Components.pdf” included in the 

“Documents” folder of the installation. 

11.18.40 

• Changing Date in Text 

“Edit > Edit Selection > Text > Change Date”. 

This applies to selected text blocks that contain a date. The new operation allows changing the date to the current 

date (today). 

The date needs to contain year, month and day, but the order is arbitrary. 
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The user is prompted with the format: “YYYY-MM-DD”. The string can be changed if the order in the text does 

not match. For instance one could input “DD-MM-YYYY”. 

Note that the separator (“-“, in this case) does not need to be the same in the text, but the new replacement date 

will use it. 

For instance: “YYYY-MM-DD” will match “2021-03-02” or “2021 03 02” or “2021:03:02”. Any separator as long as 

it is the same. However, the replacement date will use “-“. 

• Insert > Chamfer 

Reverted to previous behavior where traces that are not really part of the chamfer can be moved. 

• Import Gerber Autoconvert C to N 

This was previously the default for DRI layers or when importing files with the “.dri” extension. 

Not this feature can be turned on or off: 

 

 

11.18.37 

• New Delete Vertex Operation 

“Edit > Edit Traces > Delete Vertex”. A tool to delete the vertex common to two straight traces. Clicking on the 

vertex deletes the two traces and replaces them with a spanning trace (endpoints equal to the other endpoints of 

the removed traces). 

11.18.36 

• Improved Display of Selected D Codes and Tool Codes 
“View > Selection > D Codes” and “View > Selection > NC Tools“ now includes a count of elements also. 

• Edit Custom Font 
Read the document “Font Editing.pdf” in the installation folder. 

• New Functionality in “Go > Coordinates” 

Several new buttons have been added. 
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The “Paste” button will paste the text currently in the Windows clipboard into the X/Y fields. 

This is useful mostly for copying a pair of coordinates, for instance from an Excel spreadsheet. The pair should be 

separated by spaces. The two items will be pasted into to X and Y fields. 

The “Origin” buttons will move the cursor to the absolute origin (0,0) or relative origin (if set). 

• Mirror X Option for Print 

Useful for printing images for the bottom side of a board. 

11.18.19 

• Elements Overlapping Cursor 
The dialog showing info on the elements that overlap the cursor now show more detailed information. 

• Import GDS-TXT 
Now allows for several files to be imported in one operation. 

• Pin 1 Display Options for Components 
“Components > Pin 1 Rendering”. Has 3 options: Text, Filled, None. Previous way of rendering was None. 
Examples are shown below for the 3 modes: 
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• Select Invalid Polygons 

“Select > Special > Invalid Polygons”. Selects polygons that are not valid according to the Gerber or ODB standard 

(self-intersecting). 
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11.18.11 

• Replicate To More Than One Layer 

“Edit > Edit Selection > Replicate” now allows selecting more than one layer to replicate to. This is possible only if 

the selection to replicate is in one layer only. 

11.18.1 

• Import Gerber Components 

Support for the new Gerber components format (called Gerber X3) has been added. 

11.16.73 

• Changing Shapes of D Codes in Different Orientation 

There is a new command in the D Codes Setup dialog that selects all D Codes of the same shape independent of 

orientation. 

 
This can be used to select all D Codes that have the same shape type and dimensions, independent of orientation. 

One common use case is the following. 

Assume you have pads as shown below: 

 
and you want to convert the rectangles to obrounds. 

In the Setup dialog you can use the above command to select the two D Codes (or even select them manually. 

Then press “O” for Obround. When the dimensions dialog comes up click OK, although you could also change 

the dimensions if you wanted. 

The result will be: 
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• Several Files In Open Dialog 

One can now pick more than one file in the “File > Open” dialog. Of course, this is mostly useful for import, not 

for open. One should open only one .bin file. 

• Larger D Code Numbers Allowed 

Largest legal D Code number has been changed to 99,999. Previous value was 9,999. 

11.16.53 

• File Import Dialogs are Now Resizable 

• Import DXF Splines 

Splines are now approximated with straight segments. However, the rendering may not match exactly the one 

seen in AutoCad in all cases. 

11.16.42 

• Insert Text Aspect Ratio 

The insert text dialog has a new field called “Aspect ratio”. A value of 1.0 will have the nominal text scaling, 

Values larger than 1 will compress horizontally, while smaller than 1 will expand. 

• Moving  Center of Custom Shapes  (M) 

Sometimes one needs to move the center of M shapes that have irregular shapes. 

To do this, select one pad with the D Code to change, then move the cursor to the location for the desired center. 

Then do “Edit/Set M Shape Center to Cursor” 

• New Arc to Chords Parameter 

For all the operations that convert arcs to chords a new parameter has been added, sagitta. 

It is the distance shown as “ds” in the diagram below: 
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This is a good measure as to how well the chords approximate the arc. 

• Rotate and Mirror Transcode Report 

A new option in the dialogs has been added to generate a text file report of the D Codes that were transcoded. 

• Job Report 

“File/Report/Generate” now also includes a per layer D Code report. 

11.16.37 

• Rotate and Mirror Transcode Report 

A new option in the dialogs has been added to generate a text file report of the D Codes that were transcoded. 

• Job Report 

“File/Report/Generate” now also includes a per layer D Code report. 

• Offset Polygons 

“Edit/Edit Selection/Polygons/Offset”. 

New operation to inflate or deflate polygons. Similar to swell, but will avoid generating new arcs. For the swell 

operation the distance from the new contour to the old one is always the specified swell amount. For offset this is 

not case at the vertices. 

• New Units and Resolution 

The units selection now allows for “micron” as well as the other previous units. 

When specifying the units with text, one can use “micron” or “um”. 

There is now also a way to specify the internal database resolution. This is independent of the units. 

To do this use “Setup / Units”: 
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Note that for PCB applications, the “1 microinch” resolution is more than adequate. This was the resolution of 

previous versions of the software. The new “1 nanometer” resolution is needed when processing chip CAD data. 

• Import/Export GDS-TXT 

GDS Binary files are currently not supported. 

Only the flat part of the GDS data is imported (BOUNDARY, PATH, BOX at top-level). 

Data is converted to polygons before export. 

• Select by Line 

A new selection tool has been added, “Select/Select By Line Tool”. 

This is a tool similar to the “Select/Selection Tool” but will select elements intersecting a dragged line rather than 

a frame. 

The usual filters are considered (Only current layer etc.). 

Keyboard modifiers are: “Shift” to add to an existing selection and “Ctrl” to remove from an existing selection. 

• Copy/Paste Coordinates String 

One can now copy the text of the current coordinates to the Windows clipboard. This text can be later copied 

elsewhere, as needed. 

There are two ways of doing this. 

- By clicking on any of the coordinate display boxes in the Position toolbar (normally in the lower left corner of 

the application). 

- By pressing the new “Copy” button in the “Go/Coordinates” box. In this case the text for both coordinates is 

copied. 
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11.16.1 

• New Insert Mode: Polygons 

The “Insert” menu has a new command “Polygons”. This will allow a user to click on a number of consecutive 

edges of a polygon and, when done, insert a polygon element. 

To stop insertion and generate the polygon, double-click or press Enter twice. 

If the point where the insertion was stopped is not the start point, a connecting edge will be added back to the 

start point. 

Previously, the only way to insert a polygon was via a several step operation: 

- first one needed to insert zero width traces (“F” type D Code) 

- then select them 

- and finally run “Edit/Edit Selection/Polygons/F to Polygons”. 

The limitation of this new mode is that one can only generate polygons with straight edges (no arcs). If arcs are 

needed the “F” method shown above should be used. 

Note that it is possible to generate a polygon with holes also, but one need to use overlapping edges to travel to 

the hole and back. These are called cut-in contours: 

 

 
 

To facilitate matching vertices in the pending contour a new shortcut has been added: Ctrl+Shift+J (jump to 

closest vertex of current contour). 

• Round Chamfers for Polygons 

New command to add round chamfers at polygon vertices where two straights meet: “Edit/Edit 

Selection/Polygons/Add Round Chamfers”. 

This will replace a vertex where two straights meet with an arc tangent to both straight edges. 

There are two methods for doing this: 

- one can specify the radius of the arc (same radius will be used at all vertices). 

- one can specify the offset from the vertex to the added arc (different radiuses will result depending on the angle 

of the edges) 

11.14.59 

• Swell By Percentage 

To swell by percentage type in a number followed by a percent sign in the “Edit/Edit Selection/Swell” dialog. The 

amount to swell by will be: 

- the percentage of the width of symmetrical D Codes 

- the percentage of the largest inscribed circle diameter for asymmetrical D Code shapes and polygons. 

11.14.55 

• Export of Lavenir Environment Files (.env) 

Export of .env files has been enabled. This is useful for viewing standard Gerber files that do not have shape info. 

Aperture information can be set up by the user and saved. It then can be reused later, avoiding the need to set it 
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up again. 

“File/Export/.env” to export and “File/Import/Apertures” to import. 

• Import XNC 

Support for the XNC metadata (layer and tool info). 

11.14.49 

• New version of Layer Organizer 

This version of the Layer Organizer allows you to quickly set the color of the organized layers. You can also 

quickly control layer visibility to show only the top, bottom or inner layer view of your design. You can use the 

new “Layer Color Manager” to setup “Layer Color Templates” that make it easy for you to map each layer to one 

of the 15 available colors in our CAM editors. 

More information on this is in the “Layer Organizer Release Notes.pdf” file in the “Documents” folder. 

• Import XNC 

Support for the XNC metadata (layer and tool info). 

11.14.45 

• Update Available Prompt 

Users who do not want to be prompted when a new version of the software is available can now turn on the 

periodic check with “Help/Update Reminder”. 

• Path in Layer Names 

A new option to drop the path part in layer names (“Setup/Drop Path from Layer Names”). During certain 

import operations the layer names will contain the full path. When this option is checked, the path part is 

dropped and only the file name is kept. 

11.14.41 

• Setting Folder for Persistence/Configuration 

Software parameters / user preferences are saved in a file named ViewMate.cfg. 

These parameters are then loaded the next time the software starts. 

The default folder where this file is saved is the user’s “home” folder, given by the Windows environment 

variables “HOMEDRIVE” and “HOMEPATH”. This folder needs to be writable. 

In some cases IT personnel sets these to folders that are not writable. 

To mitigate this, there are two ways to tell the software which folder to use: 

1. Starting the software with arguments on the command line. 

“/cfg foldername”, where foldername is the path to the folder 

2. Setting the Windows environment variable “PENTALOGIX_HOME” to the path of the folder. 

11.14.35 

• Setting Layer Colors Based on Layer Type 

“Setup/Layer Colors/Set by Layer Type”. 

Will set the color of loaded layers based on the layer type. There is a default mapping from layer to layer color 

index but it can be modified using “Setup/Layer Colors/Restore Layer Type Map from File”. 

The best way to create such a file is to first save the current one, then modify the generated file with a text editor. 

This is important because the layer type strings in the file are the only allowed values. 

The default file looks like this: 
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CopperUpper=10 

CopperLower=9 

PowerGround=7 

Signal=2 

Drill=12 

Via=15 

Rout=4 

BoardOutline=4 

SilkscreenUpper=14 

SilkscreenLower=14 

SoldermaskUpper=7 

SoldermaskLower=7 

SolderpasteUpper=7 

SolderpasteLower=7 

ComponentUpper=14 

ComponentLower=13 

Note that some of strings refer to a whole set of layer types. For instance “PowerGround”  refers to PW1, GD2, 

P25 etc. 

Currently these are the only strings allowed. More can be added if needed in later versions. 

The number after the equals sign is the color index in the color list that appears when choosing a color in the user 

interface. So, for instance, 1 is dark blue in the default setup, 2 is dark green etc. 

It the colors are mapped to other RGB values, then the indices refer to the new values. 

Once the map is changed, it will be remembered the next time the software starts. 

• Components 

A whole set of operations has been added for dealing with component info. It is in under “Components” in the 

main menu. There are too many new features to describe here. 

Documentation is included in the “Documentation” folder in the installation directory. 

Please look for “Components in CAM Software.pdf”. 

11.14.17 

• Import Directory Improvement 

For directories that have both Gerber files and drill files, the drill file format, if not specified, will be computed to 

match the Gerber files rather. 

11.14.1 

• Improved ODB++ Import 

The ODB import module has been rewritten. It now supports ODB++ V8. 

The import dialog has a checkbox for using the old (legacy) import module, if needed as a fallback. 

• Text Size in Layers Toolbar 

On high resolution monitors, the text of the Layers Toolbar can be hard to read. 

A new font selector button has been added (“Font”). This allows changing the font and the size of the font.  

 

 

• Reviewing Markers from a Previous Operation 

“View/Navigate Markers” will bring up again the navigation dialog from the previous operation that generate 



©PentaLogix Inc., 1985-2025.  All rights reserved Page 19 of 80 

one, like polygon corrections, layer compare etc. If you modify the data after the operation that the markers 

applied to, reviewing the markers will still point to the old data locations. 

• Loaded Layer Marker in Layers Toolbar 

The “*” marker for loaded layers has been removed. Users complained that it was hard to differentiate it from the 

“+” marker (multiple polarities). One can see which layers are loaded by the fact that their color bar is solid. 

11.12.54 

• Gerber Import – Self-intersecting Polygons 

The handling of self-intersecting polygons has been changed. These are polygons where edges intersect at points 

which are not endpoints of the edges (this includes overlapping edges). 

These polygons are not acceptable according to the Gerber spec. 

Previously the user was prompted to auto-correct these polygons. 

Now a new options has been added to the Gerber import Options dialog: 

 

 
 

When unchecked, polygons will be left as in the import data (without prompting). 

When checked, polygons will be auto-corrected and at the end of the import a dialog will pop up to navigate the 

places where the corrections took place (only one place per polygons is marked). This allows for a quick visual 

check to make sure the auto-correction behaved as expected. 

Note that if the data is only loaded for viewing, or if one wants to re-export the polygons in the same state, 

leaving the polygons unchanged is an acceptable option. 

11.12.48 

• New Pad Shave Operation 

In addition to the “Shave Pad Tool” (in “Edit/Shave Pads/Shave Pad Tool”) a new operation has been added that 

shaves a pair of pads or a pad versus an adjoining trace. 

This is “Edit/Shave Pads/Shave Selected”. 

For this you need to select two adjoining pads or a pad and a trace and activate this command. You will be 

prompted for the desired gap between the two. Scratch elements will be inserted to shave the pads to create the 

desired gap. 

An example of before (red) and after (green) is shown below: 
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11.12.46 

• Step and Repeat Visualization 
When picking “Display outlines only” in the “Setup/Visibility and Display” dialog: 
 

 
 
the behavior has changed to display elements in the first step and repeat block. 
Previously only a box was displayed for this block also. 
This gives a better idea as to what is step and repeated. 

• Print Options 
A new option has been added to print only the contents of the frame: 
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• 3D View 
Scoring layers are now visible in the 3D view (layers of type “SCG”). 

• Generate Images in SVG Format 

SVG stands for Scalable Vector Graphics and is a standard web format. 

Files with the .svg extension can be opened in Windows by double-clicking on them. They open in a web browser 

(Internet Explorer, etc.). 

The new feature is at: ‘File/Print to “.svg” File’. 

SVG images are useful because they can be scaled while preserving smoothness. In the web browser use the 

Zoom feature. 

In the “Layer By Layer” mode, one file is generated for each visible layer and then the collection is zipped, 

resulting in a .zip file. 

In the “Combined” mode, the image colors will look different then in the CAM software, because color blending 

is done differently in SVG. 

• Gerber X2 and Netlist Info 

The new Gerber Extended V2 format (known as X2) can contain netlist info for the data elements (the net name). 

This is now implemented for import 

11.12.32 

• Import Gerber 

A warning has been added when generating data for a D Code the shape of which is undefined. Most useful for 

exended Gerber import, when the header does not define all the D Code shapes. 

11.12.22 

• Improved Gerber Extended AM Parsing 
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Parenthesized expressions are now allowed. 

11.12.18 

• NC Tool Numbers Range 

When importing NC drill and rout data, tool numbers up to T999999 are now accepted. Internally the allowed 

ranged is still T1 through T255, so tool numbers larger than 255 will be transcoded during import. 

• Larger Toolbar Buttons 

Many of the toolbars have buttons that are difficult to see on high resolution monitors. There are now new 

buttons in many of the toolbars and their size can be picked by the user (“View/Toolbars/Button Size” or 

“Setup/Preferences/Toolbar Button Size”). 

• Import .pdf 

“File/Import/PDF As Vector” now imports separate pages of the PDF file into separate layers. 

11.12.9 

• Visualizing Scratch Elements 

At times it is hard to see where scratch elements exists on a layer. There is now a quick way to select them in 

order to see where they are: “Select/Special/Scratch”. This works only on active elements, the same way as the 

selection commands in “Select/Special”. 

11.12.6 

• Toolbars Positioning 

Toolbar positions and docking are now remembered separately for different screen resolutions. This helps users 

with laptops and docking stations, where resultion can change when docked. 

Toolbars must be arranged again when resolution changes, but once set positions will be remembered. 

Another change is that toolbar positions will not need to be reset when a new major version of the software is 

released. 

11.10.73 

• Import ODB++ 

Support for dynamic text: $$JOB, $$STEP and $$LAYER. 

• Select Approximate Duplicates 

A new method to select duplicates that are not identical. They can differ by a user specified tolerance. 

“Select/Special/Approx Duplicate Elements”. 

11.10.63 

• Gerber X2 - TF.FileFunction Implemented 

The FileFunction attribute for Gerber X2 has been implemented for export and import. When importing a file set 

of Gerber X2 using Import/Directory or Import/Zip, the proper layer order is preserved. 

• Gerber X2 – Nested Step and Repeat Implemented 
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11.10.56 

• Import of PDF files 

“File/Import/PDF”. Note that only pdf files that have vector content, such as fab drawings, will give good results. 

One such example is in the Samples folder. 

11.10.40 

• Built with Visual Studio 2013. Does not neet .Net V2.0 any longer. 

11.10.24 

• This is the last release built with Visual Studio 2008. 

11.10.5 

• mproved parsing of Gerber files with modal flashes (D03). 

11.10.1 

• Communicator 

Need to tell your customer about a problem with their Gerber, Drill or Stencil data? 

Now, you can communicate with your users over email using “Live CAM Data”. With ViewMate Communicator, 

you can create a communication that includes one or more “Live CAM Views”. 

Turn on the layers you want your customer to see. Mark the location of a problem with the marker. Then click the 

“Add View” button to save the View. You can add multiple views if you have more than one issue to resolve. 

Set up your communication recipients using the “Manage Recipients” dialog. You can even create “Email 

Groups” that you can recall easily at a later date. Set up one email group to communicate with the engineer or 

PCB designer. Set up another email group to include the purchasing agent. When you’re ready to send your 

communication, just choose the email group and click the “Send” button. Your communication with “Live CAM 

Data” will be sent to your email recipients. 

Your customer can open the ViewMate Communication using ViewMate Responder. This program is included 

free with ViewMate. Your customer can navigate your views. The data is “Live”, meaning the customer can 

zoom, pan and even edit the data if needed before sending the communication back to you. Your customer can 

create their own views to share information with you. 

With ViewMate Responder, you cannot create your own communication or set up email recipients. You can only 

respond to an existing communication. 

The new program is fully documented. Just click on the “Help” toolbar button in Communicator and then click 

on either the “ViewMate Communicator Help” or “ViewMate Responder Help” link. 
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Discover an entirely new way to communicate with your customers using ViewMate Communicator with “Live 

CAM Data”! 

Best of all – ViewMate Communicator is included free of charge with any of our CAM editors. 

• Improved parsing of Gerber files with modal flashes (D03). 

11.8.1 

• Improved polygon swelling algorithm 

11.6.35 

• IPC-356 test points imported 

When importing netlist data, "099" records, if present, will be imported as pads on separate layers. These records 

were previously ignored. 

11.6.18 

• Instant Board Quote 

When sufficient information is available in the loaded data, a tentative quote for the price of one board is 

displayed in the quote button of the "Check My Design" toolbar. If that button is pressed a more accurate quote 

can be obtained instantly. 
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11.6.0 

• Easier access to endpoint alignment option 

When aligning or selecting traces and polygons there is an options to move the cursor to the endpoint only. Since 

this is a frequently needed operation, a new button has been added to Selection Toolbar and a new entry in the 

context menu (mouse right-click). 

• New button to pan up 

A new button has been added in the "Screen" toolbar to supplement the "Next Screen" button. The new button is 

"Next Screen Up" and it will step in the Y direction, rather than in the X. 

11.4.42 

• New Layer Type 

New layer type for stencil layers have been added: STU (Stencil Upper) and STL (Stencil Lower). 

11.4.29 

• Option for Transcoding Report 

During import (Gerber and others) D Code numbers may need to be transcoded to preserve the specified shape of 

the D Code. During transcoding a report file is generated. This added option has three choices (available under 

"File/Import"): 

 

 

One can: 

 disable report to file ("None") 

 generate a file called "Transcode Report.txt" in the same folder where the imported file is ("To Import 

Folder") 

 use the file that was picked previously with "File/Report/Set Name" ("In Report File"). 

• Easier Format Guessing 

The dialog that is shown when one does "File/Import/Guess" (F4)  now includes the board size limits to allow for 

changing them and trying to guess again. Previously one could only set the board size limits on which the guess 

was based in the "File/Import/Directory/Options" dialog. 

• Turn Off Full Path in Print Header 

A new option has been added to the print options called "Full path". If unchecked, only the filename part of job 

names or layer names will be printed in the header. 

11.4.15 

• ODB++ V7.0 Support 

Rotation of pads ( by arbitrary angles) in ODB++ files (introduced in V7.0 of ODB++) is now supported. 

• New Option for Aligning Layers 

"Edit/Move Layers XY Position/Align Visible Layers" (Ctrl+Q) now has a new option tab for allowing the user to 
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select which layers will be moved and which will be left standing during the alignment. There are 3 possibilities: 

 

1) "Auto" will work as this command worked before. The software will determine which layers to move and 

which to keep in place. 

2) "Lowest layer..." will keep in place the lowest layer number among the visible layers. 

3) "Current layer" will keep in the place the current layer. 

11.4.6 

• Open .bin file by double clicking 

A new command has been added to associate or dissasociate the .bin file extension with ViewMate. It is 

"Setup/Advanced/Register for .bin files". When checked, one can double-click on a .bin file in Windows Explorer 

to cause it to open. 

• Layer Info for Printing 

"File/Print" has a new option for adding a line with layer info (layer name, type, etc): "Add layer info line". 

11.2.78 

• Picking D Code for Inserting Elements 

A new user selection has been added to allow picking a specific D Code for inserting elements (pads, traces etc.). 

Previously newly inserted elements were using the current D Code (from the Current Element toolbar). That is 

still the default, but the user can now pick a specific D Code for inserting elements. 

 

 

This is useful when during insert operations the current D Code can change (due to aligning or selection) but the 

user wants to insert using a specified D Code. 

The command to pick this option is under "Insert/Using D Code". This is similar to the existing "Insert/Into 

Layers". 
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• Screen Toolbar Split in Two 

The Screen toolbar has been split into two toolbars, now called Position and Screen. This is to allow users the 

choice to turn off one or the other independently. The Position toolbar contains the units, X and Y coordinates and 

zoom, which are the items more frequently used. Users who don't need the other buttons can now turn the Screen 

toolbar off and have more room on the screen. 

• Gerber Coordinates with Decimal Point 

"File/Import/Directory" has been improved to recognize Gerber files with coordinates with decimal point 

notation. This is not standard Gerber, but such files do exists. 

• New Option for Gerber Import 

The new option is in the "File Interpreation" tab of the options dialog and controls the handling of Gerber blocks 

without a D command following a tool change (D Code change). An example is shown below: 

 
X163830Y76835D01* 

D24* 

X161290Y75565* 

X157480Y76200* 

 

The question is how to interprest the block: X161290Y75565* 

According to the Gerber spec this should be a move, but some software outputs it expecting that the D command 

in the previous block should be preserved (D01). 

Because of this a new option has been added: 

It is safest if Gerber files contain a drawing D command in every block (D01, D02 or D03) but this is not always 

the case. 

11.2.74 

• Trim Traces Improvement 

"Edit /Trim Selected Traces" now has an additional parameter for clipping. It is a percentage number that allows a 

user the set the maximum percent of a trace that will be clipped. A maximum length of the clip parameter existed 

before and it is still present. Only if both are satisfied will a trace be clipped. 

11.2.71 

• Check For Updates 

"Help/Check For Updates" will now open in a web browser instead of a child dialog of the application. This 

allows the application to be closed while the update is being done. 

• Import Directory Improvements 

Better guess for format of drill files. 

11.2.58 

• New Parameter for Timming Traces 

A new parameter has been introduced for clipping selected traces. This specifies a maximum length. If the 

clipped portion would exceed this length the trace is not clipped: 
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• Support for Gerber Extended "LN" Directive 

A new option has been added for importing Gerber Extended data : 

 

 

When the "LN" option is checked, the string that appears in the "LN" directive (Layer Name) in Gerber Extended 

files will set the name of the layer in the CAM software. 

 

11.2.56: 

• Smart DFM Improvements 

The algorithms used to check for violations have been improved. 

11.2.43: 

• Printing on White Background 

The "Screen colors on white" has been improved to print the exact colors visible on the screen. The "Use Raster 
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method when printing" checkmark must be checked for this to work. This  is useful when one wants the printed 

image to have the same colors as the screen but one wants to save ink and not print the black background. 

• Polygons Filter Shortcut 

A new shortcut has been added for using polygons as the selection filter: "Ctrl+Shift+Y". This applies to the filter 

box in the Selection Toolbar. 

• New Selection Filters 

The filter combobox that appears in the Selection Toolbar (and other dialogs) now has several new added items: 

"Plated Holes", "Non-plated Holes" and "Via Holes".  This restricts selection and operations that work on active 

elements to just pads of type "N" and mapped to holes of the specified type. 

• D Code Layer Usage Report 

"File/Report/Generate" will now also show on what layers each D Codes is used. 

11.2.31: 

• Turn On and Off a Range of Layers (Visibility) 

A new way of changing the visibility of a range of layers has been added to the layers toolbar. To turn ON a range 

of layers click on the first and Shift+double-click on the last in the range. Similarly to turn OFF a range of layers 

click on the first and Ctrl+double-click on the last. 

• Stretch Traces Orthogonally 

A new option has been added to allow only orthogonal (horizontal, vertical or at 45 degrees) stretch of straight 

traces: "Edit/Orthogonal Stretch Only". 

• Paint and Scratch Optimize for Layer 

A command has been added to the right-click menu in the layers toolbar: "Paint and Scratch/Optimize". This will 

attempt to minimize the number of paint to scratch transitions on a layer by merging groups that do not interfere 

and adding scratch polygons as holes to containing paint polygons. 

• Guessing Layer Types 

A command has been added to the right-click menu in the Layers Setup (F10) dialog: "Guess layer types from 

name". It will attempt to determine the type of a layer ("CPU", "CPL" etc.) from the layer name and extension 

using CAD software standard naming conventions. 

11.2.26: 

• Smart DFM Improvements 

New methods to correct errors in the data have been added. One can now clip to the board outline elements that 

cross from inside of the outline to the outside. This happens often on the silkscreen layers. 

The quote phase now brings up the web browser in a separate window, making it easier to navigate the quoting 

website. 

• Distance to outside edges 

The edge-to-edge measurement tool (right mouse click - "Edge To Edge Measurement Tool") now displays the 

distance to the outside edges of the two picked elements, in addition to the distance to the inside edges. 
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11.2.22: 

• View Layers where a D Code appears 

A new command has been added to the "Setup/D Codes" (F5) dialog that will display the list of layers that 

contain the D Codes currently picked in the dialog. The name of the new menu command is "Layers". 

11.2.8: 

• Excellon Format 1 Import 

An option has been added to the "Options" dialog for "File/Import/Drill & Rout" to allow setting either Format 1 

or Format 2 as the format of the data to be imported. This is important when the Excellon file does not contain a 

FMAT statement because Format 1 and Format 2 commands have different meanings. Previously Format 2 was 

assumed as the default. 

11.2.1: 

• Editing Layer Names 

New commands have been add to the context menu (mouse right-click) in the "Setup/Layers" dialog (F10): "Load 

layer names from file" and "Store layer names to file". These allow saving the layer names to an ASCII text file and 

also loading the layers names from a file. This can be useful in several ways: 

 To load the names from a fixed template of layers names 

 To edit the names when a large number of names need to be changed. To do this, one can do the following: 

save the current name to a temporary text file, edit the file with notepad or other text editor that allows for 

group replace operations, finally reload the names from the just edited file. 

11.0.80: 

• US QuickTurn PCBs 

New Smart DFM rule set and prices for quick turn (one day or more) PCBs made in the USA. 

• Improved Copy and Paste 

The "Edit/Copy" (Ctrl+C) and "Edit/Paste" (Ctrl+V) commands now use as reference point the position of the 

cursor when the copy command is performed. Previously the lower-left corner of the bounding box of the 

selected elements was the reference point. 

11.0.74: 

• Improvement In Trim Selected Traces 

The "Clip" operation of "Edit/Trim Selected Traces" has been improved. It now clips traces extending by small 

amounts over another trace even at points that are not close to the endpoints of the other trace. Previously the 

clipping was done only for situations where traces intersected close to their endpoints. 

This new method is useful to clean up inaccurate polygon fills, such as the one shown in the image that follows: 

 



©PentaLogix Inc., 1985-2025.  All rights reserved Page 31 of 80 

 
 

 

The above image is shown at zero-width to expose the nature of the fill. After the trim operation, the result will 

look as shown in the next image: 

 

 

 
 

11.0.71: 

• Tool For Panelizing 

A new command has been added: "Edit/Layers Stackup/Combine By Board Number". This command operates on 

all visible layers and, if several layers have the same board layer number, it will combine those layers into one 

(merging into the first layer with that board layer number). Although this is a general purpose command that can 

be used for other purposes also, its main use it to facilitate panelizing two (or more) different jobs. 

The jobs are usually on separate sets of layers but one wants to combine them into a set of panel layers. For this 

one can apply the following steps: 



©PentaLogix Inc., 1985-2025.  All rights reserved Page 32 of 80 

1. Place the second set of layers at the desired X and Y location by using one of the move commands.. 

2. Set the board layer numbers for each layer in the second set so it matches the board layer numbers in the 

first set. This can be done in the "Setup/Layers" dialog. 

3. Execute the "Combine By Board Number" command. 

• New Global Selection Filter 

A new filter has been added for selecting only paint elements (ignoring scratch elements). It is called "Paint 

Elements". Previously there was only a filter for selecting "Scratch Elements". 

11.0.59: 

• Feedback during Move and Copy 

For operations that move or copy the selection the cursor will drag a box representing the limits of the selection 

(to provide feedback to the user). These operations are: "Edit/Edit Selection/Move", "Edit/Edit Selection/Copy" as 

well as "Edit/Copy" and "Edit/Cut". 

• Shaving Pads 

A new command has been added which activates a tool for shaving pads ("Edit/Shave Pads"). It is a two step 

operation: first click on the pad to shave, then click at the edge of the desired shave (inside the pad). The width of 

the shave can also be typed while in the second step by pressing "X". This tool is useful for correcting occasional 

DRC/DFM errors, such as encountered during Smart DFM. 

• Including the Frame in Printed Output 

An option has been added to the printing dialog to include the frame in the printed image. It is "Print Frame also". 

11.0.42: 

• Large Offsets in Gerber and Drill Files 

There are files where all the data is offset by a very large amount  which violates the CAM data limits of 1000 

inches (or 10m in metric). Now such data can be imported. One needs to use "File/Import/Guess" ("F4") or 

"File/Import/Directory" for this purpose. 

11.0.28: 

• Check My Design 

A new button has been added which allows the user to email to PentaLogix the data currently loaded. This is 

intended primarily as a way to help users who have trouble with correcting errors found in Smart DFM, but can 

be used for any purpose when users want help from PentaLogix.  

11.0.22: 

• Printing in Screen Colors 

A new method has been added to the "File/Print" dialog: "Screen colors". This will print the image the same way it 

is displayed on the screen. Since the background of the image is black, this will waste a lot of ink when printing to 

paper, but it is useful when printing to files, such as PDF files. 

11.0.14: 

• Import Zip Available 

"File/Import/Zip" is now available in ViewMate also. This command was previously grayed out. 
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11.0.9: 

• Quick Way to Insert Round Polygons 

A new tool is available to insert round polygons It is "Insert/Circle/Polygon" and there is also a button for it on the 

"Insert" toolbar (shown as a filled circle). The operation takes two clicks: one for the center of the circle, the other 

for a point on the circumference. 

When the goal of the operation is to insert round pads, the "Insert/Pads" tool is preferable, but the insert round 

polygon can be useful when making corrections (filling in areas or scratching away unwanted copper). 

11.0.1: 

• Online Ordering of PCB Boards 

A new online quote and order module has been added (with “Smart DFM”). It is activated via the “Smart DFM” 

menu command after the data for a one-up is loaded. 

The quote module will step the user through a complete setup and preparation of the board data to be ready to 

send to a manufacturer. The data is checked against the DFM rules of the manufacturer(s) and any errors are 

displayed. The user can manually correct them or use many of the automatic corrections provided. At the end of 

the process, an online quote can be requested and, if desired, an online order placed. 

The user is thus assured that the board will be manufactured without any further changes needed at the 

manufacturer side and without delays. The pricing is also very competitive as the manufacturer receives “clean 

data” that matches their DFM rules. 

• New Tool for Selecting a Set of Connected Elements 

“Select/Connected” is a new tool that allows selecting elements that are connected (touch or overlap). Once the 

tool is activated one can click close to an element and that element and all elements in that layer which are 

connected to it (either directly or indirectly via other connecting elements) are selected. This command works 

only on visible elements and ignores scratch elements. 

Possible uses for this command: 

 To generate a board outline. One can click next to one element in the board outline and all connected 

elements will be selected. This is most useful when traces in the outline do not line up perfectly on top of 

each other (they intersect or overlap). If one wants to generate a “correct” outline after such a selection is 

made, the “Edit/Trim Selected Traces” command can be used. 

 To check netlist connectivity. This is not really a netlist, because it only works on one layer and ignores 

scratch elements, but it can be helpful in the case simple designs. 

• Automatic Alignment of Drill Layers 

A new command (“Edit/Move Layers XY Position/Auto-Align Drill Layer”) aligns the drill layer (of type DRI or 

PTH) to a component layer (CPU or CPL). It will attempt the alignment by trying to match all plated holes in the 

drill layer to pads in the component layer. Each hole needs to be matched for this operation to succeed, so the 

component layer needs to have at least as many pads as the drill layer. Only visible elements are considered. 

10.6.71 

• A Quick Way To Insert A Rectangular Polygon 

“Insert/Rectangle/Polygon” will insert a rectangular polygon. The user can pick the two corners of the rectangle. 

This can be used as a quick way to make corrections to a design by filling in (inserting a paint polygon) or 

deleting (inserting a scratch polygon). 

• Order of 90-degree Trace Pair 

When inserting 90-degree trace pairs (“Insert/Special Linear Trace/90 Degree Trace Pair”) one can toggle the 

orientation of the first trace with the Shift key. Previously the first trace was always horizontal. 
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• Dimensioning Improvement 

When inserting orthogonal (horizontal or vertical) dimensions (“Insert/Dimension”), the choice between 

horizontal and vertical is now made from the location of the third picked point (for the text position). Previously 

this was determined from the endpoints of the measurement (the first two picked points). 

10.6.50: 

• Layer Names Shown in Layers Toolbar 

The Layers Toolbar (“View/Toolbars/Layers”) now shows the layer names also in addition to the layer number 

and color. The name appears to right of the color box, so one needs to widen the toolbar to show as much of the 

layer names part as desired. 

One can widen the layers toolbar by dragging the right edge with the mouse. Once set to a new width that width 

will be remembered. It is a user preference as to how much screen space one wants to give up to display layer 

names. 

• Showing Scratch Elements in Contrasting Color 

There is a new command to set the display mode so that is shows scratch elements as paint in a contrasting color. 

This is sometimes useful when trying to understand the paint-scratch setup of a layer. Note that this works only 

on combined (mixed-polarity) layers and not on whole layers that are marked as scratch. 

The shortcut to toggle the mode is “Ctrl+H” and the command can also be found in the “Setup/Visibility and 

Display” as “Scratch contrast”. 

• Inserting Arc Chamfers of Given Radius 

A new command has been added to allow inserting arc chamfers of a fixed radius, specified by the user: 

“Insert/Chamfer of Radius”. The chamfer is added at the joining point of two linear traces. After the tool is 

activated, the user needs to click close to this joining point and an arc chamfer is inserted. 

10.6.34: 

• Marking a Midpoint 

A new tool to insert a marker at the midpoint between two points picked by the user. These two points are 

usually picked by aligning to elements, but the tool is general purpose. It is activated with “Go/Mark Midpoint”. 

It stays active until canceled. Useful for creating reference points when constructing complex geometries. 

10.6.0 

• New Method for Correcting Self-Intersecting Polygons 

When the input data contains self-intersecting polygons, they need to be corrected so that they can be used in 

later steps of the CAM process. This correction can happen when the data is imported (the user is prompted for 

doing the correction during the import) or can be done later on selected polygons (with “Edit/Edit 

Selection/Polygons/Make Well Formed”).  This existed already in previous versions of the software. This version 

adds a new correction method. There are now two methods available, which can be picked by the user via the 

command “Setup/Self-intersecting Polygon Correction”. These two methods are called: 

 Even-odd method 

 Non-zero fill method 

It is easiest to understand what they mean by looking at the images in the dialog used to pick the method. The 

most common method (and the only one previously available) is the “even-odd method”. However, some 

software packages generate polygons that need to be corrected using the “non-zero fill method”. 

• Polarity Combine / Separate Improvements 

The operation of the commands which separate layers of mixed polarity or combine layers (“Edit/Paint and 
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Scratch”) has been improved. The layer stackup of layers which are not involved in the operation is preserved. 

Previously, empty layers were eliminated during “Combine All”. 

Undo has been added to all the operations in this group. 

10.4.31: 

• Deleting Holes from D Code Shapes 

A new command has been added to the “Setup/D Codes” (F5) dialog. It is “Operations/Remove Holes”. It will 

remove holes from all D Codes which have holes. This includes standard shapes with holes, like C (an annular 

ring), and custom shapes also (M). The operation works on the D Code (or D Codes) selected in the dialog (shown 

in blue background). 

• More Components Information 

A new command has been added to display component related text, when such information is available. It is 

“View/Info/Components Text”. Currently this information is extracted when importing ODB++ files (if they 

contain components information). 

New features 10.4.30: 

• Dragging the view 

The view can be dragged by holding the mouse left button down and dragging. This has been available for some 

time in our software but required holding down the Ctrl and Alt keys while dragging. We have now changed the 

code so one can drag without Ctrl and Alt being pressed. This will work only if no command-tool is active, such 

as Select or others. If a command-tool is active then pressing the left mouse button will activate the command and 

to drag one needs Ctrl and Alt pressed. Note also that if you want the view to be dragged in real time, you need 

to enable it with “Setup/Preferences/Draw View In Real Time”, otherwise the view will only be updated at the 

end of the drag. When there is a lot of data in the current job dragging in real time may cause flickering because it 

takes longer to redraw each intermediate step. 

• Improved ODB import 

More support for new features in ODB++ V7.0. 

New features 10.4.0: 

• Copy, Cut and Paste 

The standard Window commands for copy, cut and paste have been implemented, with the usual shortcut keys: 

Ctrl+C, Ctrl+X and Ctrl+V. They are in the “Edit” menu and have buttons in the main toolbar. 

Copy and cut work on the selection, so one first needs to select elements. They both copy the selection to the 

Windows clipboard and cut also deletes the selection (similar to “Edit/Edit Selection/Delete”). Later on, the 

clipboard data can be pasted (into the same program or another instance of this program or another PentaLogix 

CAM package). The data will be pasted into the same layers where it was originally, but the location (X, Y) can be 

different. The rule is that the position of the cursor over the selection when the copy was done (copy or cut) will 

match the position of the cursor when the paste is done. So a cut and paste can be used to move selected data 

from one (X, Y) location to another: select, position cursor, cut, move cursor, paste. 

• Pasting CAM Images Into Documents 

The current view can be copied to the Windows clipboard using “View/Copy View To Clipboard”. The resulting 

image can then be pasted in a variety of documents, such as a Word file, an email etc. without needing a screen 

capture program. 
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• Button Names for “Favorite Commands” Toolbar 

Buttons in the Favorite Commands toolbar can now be given names in addition to mapping them to bitmap 

images. After right-clicking on the button, the new option is called “Change Text”. Another new feature of the 

Favorite Commands toolbar is that the first nine buttons can be activated with shortcuts: Alt+1 through Alt+9. 

And finally, the button sizes have been increased from 16 by 16 pixels to 24 by 24 pixels to make it easier to 

generate bitmap images for the buttons. 

New features 10.2.71: 

• Toolbar for Favorite Commands 

“View/Toolbars/Favorite Commands” displays a customizable toolbar for favorite commands. This is useful for 

often used commands which are nested deep in the menu structure and can be accessed quicker this way. The 

toolbar is described in more detail in the document: “Favorite Commands Toolbar.pdf”. Look for it in the 

installation folder or on our FTP site (ftp.pentalogix.com/Documents/AppNotes). 

New features 10.2.45: 

• Easy Way to Navigate Selected Elements 

A new command (“Select/Navigate Selection”) has been added to allow for easy navigation of the currently 

selected elements. It brings up a dialog with the usual “Next” and “Previous” buttons that allow for easily 

stepping over all selected elements. 

Note that if one changes the selection while the navigation dialog is shown, the new selection will not be reflected 

in the dialog (one needs to close and reopen the dialog). 

New features 10.2.18: 

• “Edit/Edit Selection/Polygons/F To Polygons” 

A new user option has been added “Path can continue at overlap”. If checked, will enable special processing of 

overlapping traces, so that a contour can continue at vertices where traces overlap. If not checked, will force 

contours to use the traces as they are. 

New features 10.2.0: 

• New Commands For Trimming Traces 

These are commands for correcting pairs of traces that either are close to each other at endpoints (but do not 

connect) or overlap slightly at endpoints. These situations sometimes arise because of rounding errors in the CAD 

output or inexact manual insertion of traces. 

The two types of problems (“Connect” and “Clip”) and their corrections are illustrated below: 
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These problems can be corrected in one of the following ways: 

- by picking the two traces (with a mouse click or the Enter key). This is “Edit/Trim Traces” and acts as a tool 

(it stays active until the user cancels it). 

- by first selecting all the traces that one wants to correct and then issuing the command “Edit/Trim Selected 

Traces”. A dialog comes up to allow the user to specify which operation is to be done: “Connect”, “Clip” or 

both and a parameter which determines how far apart the endpoints can be for connecting. 

There is a button for the tool version of the command in the “Edit” toolbar. 

Both linear and arc traces can be trimmed. 

• Converting Negative Layers To Positive 

Negative layers can now be converted to positive by using paint and scratch. A paint polygon (or several paint 

polygons) will be inserted before all data to represent the background copper and then the polarity of elements in 

the original negative layer will be changed so that the result looks the same. 

If the data on the negative layer contains the board outline, it will be used to generate the background copper 

polygons. Otherwise the frame will be used for this purpose, so it needs to be positioned before the operation to 

surround all data on the layer. 

This operation is useful if one later needs to combine negative and positive data in a panel. 

The new commands are: 

- “Edit/Convert Negative To Positive”: allows the user to specify which layers to convert 

- Right click on layer in the Layers Toolbar, then “Convert To Positive”: converts the picked layer only 

• “Insert/Into Layers” 

A new command to allow users to specify the layers where new elements will be inserted using the “Insert” 

commands. The user can pick one of two modes: 

 Active Layers 

 This is the same as insert used to work previously. Elements will be inserted in the active layer or active 

layers depending on the state of the “Only” checkmark for the current layer (in the Current Element toolbar). 

 Specified Layers 

 User can specify the layer (or layers) where elements will be inserted. Changing the current layer or the 

“Only” checkmark does not affect where the elements are inserted. This new mode allows, for instance, to 

insert into one layer while aligning to elements in another layer. 

In both modes, the layers that will receive elements will be marked with a “>” before the layer number in the 

layers toolbar. Since more room is needed now for displaying the layer number text, the color box will be 

narrower, but one can adjust that by widening the layers toolbar (drag the right edge of the toolbar). 

• “File/Open Options” 

Groups options that apply to “File/Open” (reading in .bin jobfiles). 

- “Ignore Preferences From Jobfiles” existed previously but was located in “Setup/Preferences”. 

- “Do Not Restore Custom Colors” is a new one and will cause the software to ignore custom color definitions 

(RGB) from jobfiles. This helps users who want to always preserve their own custom color setups (done with 

“Setup/Layer/Colors” -> “Redefine Color”). 

• New Option For Selection 

A new user-settable option has been added to enable the selection using a frame of elements which cross 

(intersect) the selection frame. When this option is off, only elements which are completely inside the frame are 

selected (this was the previous behavior of the software). 

The option can be found in “Select/Options” and is called “Select also elements that cross the frame”. There is also 

a button for this in the Selection Toolbar (“View/Toolbars/Selection”). It has been added next to the “Inside” 

button. 

• “File/Import” (“Guess”, “Directory” and “Zip”) 

 the interpretation of the format of Gerber files has been improved. 
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 for Sieb & Meyer drill files: the format guessed (or set by the user after the guess) will override the format 

implied in the Sieb & Meyer file (for instance format %%3000 automatically implies metric, trialing zeros, 3.3 

and this can now be overridden). 

• “Setup/Frame/Surround All Data” (Ctrl+W) 

State of “zero-width” display (“O”) is taken into account when computing the size of the frame. 

Changed features 10.0.10: 

• Shortcut keys for Layers Toolbar 

An options has been added to enable shortcut keys for the layers toolbar. This is in the layers toolbar context 

menu and is called “Shortcuts enabled”. Shortcuts were removed a few versions back because they were deemed 

dangerous, as they have a different meaning than the same shortcuts in the main view. However, some users 

complained and wanted them back so now they are restored (if enabled by the user). 

The shortcut keys available are the same as in the past: “V”, “N” and “S”. Note that “V” and “N” work on the 

whole board layer, just as in the past. 

New features 10.0.1: 

• “Edit/Move Layers XY Position/Move Layer Tool” 

A new tool has been added to facilitate layer alignment. The command will activate a tool which consists of two 

steps: 

 First the user picks an element in the layer that he desires to move. This is done by moving the crosshair 

close to the element and then clicking (or pressing Enter), similar to how one selects an element. 

 Next the user picks the corresponding element in another layer the same way as in the previous step. 

At this point the layer of the first element will be moved so that the first element is now on top of the second 

element (and hopefully the layers are aligned).  The whole cycle can then be repeated again for moving another 

layer. When done, press Escape to cancel the move layer tool, or deactivate it by clicking on its menu entry.  This 

command has the shortcut key combination Ctrl+Shift+Q. 

• “Edit/Move Layers XY Position/Move By Displacement” 

This command has been improved to make it easier to align layers. Previously the command dialog included only 
the X and Y displacements and it moved the “active layers” (as determined by layer visibility and by the “Only” 
button next to the current layer in the Current Element toolbar).There are two improvements to this command: 

 One can now pick the layers to move in the dialog. There is a text box where one can type in a comma 

separated list of layer ranges, such as “3, 7-9, 15” (one can also type “All” here). This list is initialized to the 

currently active layers, so that the command acts as before if the user leaves the layers text box alone. 

 The X and Y displacements in the dialog are initialized to the result of the most recent distance measurement 

command (if any). This allows the user to previously do a distance command (“D”) to set the move 

displacement. 

• Explicit Units  

All the dialog items that refer to a coordinate or a dimension now accept numbers followed by optional units, 

independent of the current units in use.  For instance in the “Move Cursor To” dialog box one could enter 

“2.3cm” for X, even though the current units may be “inch”. This would cause the cursor to move to 0.905512 

inches. The acceptable values for the units are the same as the ones shown in the “Coordinate Units” box: “inch”, 

“mil”, “cm” or “mm” or any prefix of them which is unambiguous (for instance “in” or even “i” will work instead 

of “inch”). 

• “Setup/Preferences/User Confirmation For”  

confirmation for dangerous operations.  A new group of preferences that can be turned on or off. When on, they 
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will cause the corresponding operations to prompt for user confirmation before they are done. Currently two 

such operations covered: 

 Delete Selected: will prompt for “Edit/Edit Selection/Delete” 

 Drag And Drop Layers: will prompt during a drag and drop in the layers toolbar 

 These are intended as a safety feature to protect against unintended operations, especially since “delete 

selected” has a shortcut key (Delete) which can easily be pushed by accident. 

More such operations can be added in the future. Please let technical support know which you would like added. 

• “Setup/Preferences/Wheel Forwards Decreases Zoom”  

user preference For those who are used to have the zoom decrease when the mouse wheel is moved forwards and 

increase when the mouse wheel is moved backwards. 

• New Shortcut Key Ctrl+Shift+U:  

to return to last selection criterion picked previously. This is most often picked from the droplist in the Selection 

Toolbar (“Any”, “Pads”, etc.). There are many different criteria in that list and many times one wants to alternate 

between having one particular criterion picked, say “Polygons” and not having anything picked (“Any”). With 

this new shortcut one can do this from the keyboard only. After picking a criterion ,“U” will pick “Any” and 

“Ctrl+Shift+U“ will bring back the criterion picked before. 

• “Setup/D Codes” (F5), custom shapes 

Custom shapes (M-type) setup dialog: now has two added buttons, “Import” and “Export”. These will 
import/export to/from Gerber the current custom shape. These commands were available previously as a 
separate step in the “Custom Apertures” menu of the main dialog, under “Import From File” and “Export To 

File”. The addition of the new buttons saves some operator steps. 

• “Edit/Edit Selection/Polygons/F To Polygons” 
Algorithm has been improved. 
Three options have been added for handling polygon holes (when nesting is requested). 

 “Holes cannot overlap”: if two holes overlap one of them becomes a container 

 “Overlapping holes are merged”: two overlapping holes are merged to make a larger hole 

 “Overlapping holes not merged”: the overlapping area of two holes becomes a new container 

• “File/Import/Guess-Directory-Zip” 

 Now supports the Excellon format for decimal placement (000.000).  

 The results dialog has been changed. 

− The leading, trailing, all present, decimal present radio buttons will enable/ disable the ‘m’ and ‘n’ labels 

in a similar way that the Import/Drill & Rout/ options  dialog behaves. 

− If the size the user selects creates a coordinate value outside the 1000 inch, 1000 cm limit, an error is 

reported and the “OK” button is disabled. 

− Files with no data (drill with tool sizes but no drill data) will now report the board size as “0 x 0” instead 

of “No Data Found”. 

New features 9.8.70: 

• Drag and Drop in Layers Toolbar 

One can now drag and drop layers to reposition them. In the layers toolbar click on a layer and drag it to the 

desired spot. The insertion mark will be shown before the layer where the drop will occur. The number (and 

name) of the layer being dragged can be seen in the status line. 

• New shortcut keys (accelerator keys) 

 Ctrl+Space: for the main view context menu (or mouse right-click) 

 Ctrl+Shift+F10: for “View/Visibility/Layers/Only Visible”. This is a command that allows making visible just 
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a group of layers (a comma-separated list of ranges). 

• “File/Import/Gerber” – “Options” 

A new option has been added to the “File Interpretation” tab: “If data follows M02”. It has two possible options: 

“Make new layer” and “Same layer”. 

This applies to the (rare) cases where a file has a Gerber M02 command (End Of Program) followed by more 

Gerber data. If “Make new layer” is picked, the data that follows is put into a new layer. This is the more common 

setting (and the behavior of previous versions of the software). Sometimes, when the data that follows belongs to 

the same layer (and perhaps starts with scratch elements), the “Same layer” setting gives the desired results. 

• D Code Size Rounding 

In “Setup/D Codes” (F5), the “Operations” menu has a new rounding item. In addition to the existing “Round to 

closest mil” (or “Round to closest 0.01 mm” in metric mode) there is now “Round to closest 0.1 mil” (or “Round 

to closest 0.1 mm” in metric). 

•  “Edit/Edit Selection” 

 “Paint And Scratch/Raise To Top” 

 A new command that deals with the paint/scratch order of the selected elements. This command will change 

the polarity order so that the selected elements will be above (on top of) all the unselected elements (layer by 

layer). All paint elements in the selection remain paint and all scratch elements remain scratch, just that they 

will come earlier in the paint/scratch order when all elements in a layer are considered. They will be 

“promoted” on top of everything else and hence guaranteed to be visible. 

 “Polygons/F To Polygons” 

 A new options has been added to facilitate processing of complicated drawings. It is “Allow Intersecting 

Holes”. This option is only relevant when “Nest Polygons” is checked. It allows for intersecting holes and 

will merge them to make combined holes. 

• “Setup/Frame/Surround All Data” (Ctrl+W) 

A new option has been added “Consider scratch elements also”. When unchecked, scratch elements will not be 

considered in the computation. When checked, scratch elements are considered the same as if they were paint 

(this was the previous behavior of this command). 

• Mapping D Codes to N-type shapes 

The user interface for re-mapping non-N shapes to N-shapes in “Setup/D Codes” (F5) has been improved. 

New features 9.8.50: 

• New Layer Types 

The following new layer types have been added: 

PTH Drill – Plated Through Hole 

NTH Drill – Non plated Through Hole 

BLI Drill – Blind vias 

BUR Drill – Buried vias 

ROU Routing – generic 

RPE Routing – external plated 

RNE Routing – external non plated 

RPI Routing – internal plated 

RNI Routing – internal non plated 

PLA Plating 

SCG Scoring 



©PentaLogix Inc., 1985-2025.  All rights reserved Page 41 of 80 

•  “File/Import/Gerber” - “Options” – “File Interpretation” 

 “Zero-Length Draws”: an additional option has been added: “Ask”. Previously there were only two 

possibilities: “Make pads” and “Ignore”. Now there are three: “Make pads”, “Ask” and “Ignore”. 

“Make pads” A pad will be generated to replace the zero-length trace 

“Ignore” Zero-length draws will be ignored 

“Ask” The user will be prompted and given one of the above choices 

 “End of Block Characters”: an additional option has been added: “Auto”. When “Auto” is selected, the 

software will try to determine which the proper setting is for the file being imported. 

• “View/Grid/Display Grid” (G) 

The grid points are now rendered with 5 pixels. The previous 1-pixel grid was difficult to see on high resolution 

monitors. 

•  “File/Import/Guess- Directory- Zip” 

 HPGL- recognition has been improved. 

 IPC-D350/ IPC-D356 – now searches in the comment areas to determine type. 

 “Tool diameters use opposite units”- checkbox has been added to the results dialog for drill files. When 

checked, the tool codes will use the opposite UOM than the data (inch – mm, mm – inch).  To use this feature 

in import directory and Zip, highlight the file in the scan results then press “Edit Format”. 

New features 9.8.20 / 25: 

• New Selection Criterion 

A new entry has been added to the selection criteria in the Selection Toolbar. It is called “Scratch Elements” and, 

when active, will only select/pick elements that have scratch polarity inside a layer. Note that if the whole layer is 

set to scratch, that will not cause elements in it to be picked. 

• “Setup/Preferences/Splash Screen” 

Allows enabling or disabling the display of the splash screen at program startup. 

•  “File/Import/Guess Directory Zip” 

 TAP format drill files with T-Code definitions in the header section will now use the T-Code value rather 

than the hole size number.  The ‘n’ value still defaults to three.  The ‘m’ value is now calculated by 

subtracting the ‘n’ value from the total number of digits in the coordinate data. 

 The results dialog now resizes better. 

 Gerber files that use CR/LF instead of ‘*’ are now recognized. 

 Recognizing HPGL and HPGL/2 files has been improved. 

New features 9.8.5: 

•  “Edit/Edit Selection/Polygons/F To Polygons” 

Algorithm has been improved. 

New features 9.8.0: 

• Inserting Scratch Elements Directly 

One can now insert scratch elements into any layer. 

Previously, if one wanted to add new scratch elements, one needed to add them to a scratch layer (the whole 

layer was marked as scratch). While that is still possible, there is a new way to insert scratch elements: the 

commands “Paint” and “Scratch” in the “Insert”menu. There is also a “scratch” button on the Insert toolbar, 

which will cause scratch elements to be inserted when the button is depressed (active). 
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While scratch mode is active using any of the above commands, any of the elements inserted with the normal 

insert commands (“Insert/Pad”, “Insert/Trace”, etc.) will be scratch elements.  More precisely, scratch elements 

will be inserted into positive layers and paint elements into negative layers, the end result being that they will 

scratch away from copper. 

Note that the “Only” selector next to the layer box in the “Current Element” toolbar will be taken into account (as 

always the case with insert operations). So, if you want to insert into one layer only, make sure that the “Only” 

selector is checked. 

• Selecting A Particular Element When There Are Multiple Stacked Elements 

Sometimes there are multiple stacked elements in the same layer. Often this is the case with stacked pads 

(perhaps a scratch pad to created a clearance and then a paint pad). Since they have the same center, it was 

previously difficult to select a desired element (just the scratch or 

just the paint in the example above). 

There is now a new way to do this. By executing the select command repeatedly, the selected element will cycle 

through all candidates in order and one can stop when the desired element is selected. This means double-

clicking repeatedly (or single-clicking repeatedly when the selection tool is active). 

• Layer Colors 

There are new commands for saving and restoring the layer color setup. The color setup consists of the color 

index for each layer (a number between 1 and 15, which maps to one of the 15 colors that can be set at any time) 

and the color composition (RGB) of each of these 15 colors. 

These commands are “Setup/Layer Colors/Save To File” and “Setup/Layer Colors/Restore From File” and they 

allow saving and restoring the configuration. 

To make such a setup the default setup (loaded when the program starts) the command “Setup/Layer Colors/Save 

As Default” should be used. 

Also, the complete color setup is now saved in .bin files. Previously only the layer indices were saved. 

• Distance Measurement 

There are several changes and new features in the distance measurement commands (“View/Distance”). 

 The distance is now displayed only in the view (next to the cursor). The Screen Toolbar will display relative 

X and Y displacement from the start of the distance measurement. The screen display also includes the angle 

from the start of measurement. 

 The “distance from edge” measurement has been merged into the distance tool. Is it now an option that can 

be turned on and off (“View/Distance/From Edge”), so there is only one distance tool with two modes. 

 The command to measure the edge-to-edge distance between two selected elements has been replaced with a 

tool (“View/Distance/Edge To Edge Measurement Tool”). While this tool is active one can click on two 

elements (click on first, then click on second) and the edge to edge distance between these two elements is 

displayed in the status line. 

• Transcoding NC Tools By Descending Size 

The tools setup dialog (“Setup/Tools Codes” or “Shift+F5”) had two buttons for transcoding tools by ascending 

size. These have been combined into one button “Transcode By Size” with two more methods added to allow 

transcoding by descending tool sizes also (previously only ascending order was implemented). 

The four methods are: “Ascending”, “Ascending By Type”, “Descending” and “Descending By Type”. 

• “Setup/Preferences/Center On Wheel Zoom” 

Controls how the zoom happens when zooming with the mouse wheel. When this option is active (checked) the 

zoom is combined with a pan so that the position where the zoom started becomes the new center of the view. 

• “View/Coordinates Origin/Set Relative Origin” 

This is a newly added command that sets the relative origin at the current cursor position. It takes the name of the 

previous “set relative origin tool” (and also the shortcut Shift+R) which is now renamed “Relative Origin Tool” 
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and has no shortcut key. However, it keeps its button on the Screen Toolbar. 

• “File/Import/File Path Options/Current Directory Is Set On Import” 

This is an options that can be turned on or off. When on, the current directory is set to the path of the filename 

imported. This can be desirable if one imports files by dragging and dropping (rather than using the File/Import 

dialog). 

• “File/Import/Drill” 

A new option (in the “Options” dialog “Data Format” tab) called “Tool diameters in opposite units”. When 

checked, the tool diameter values read in will be interpreted in the opposite units from the ones specified in 

“Units”. The value in “Units” will be used to interpret coordinates. If the file contains unit directives, such as 

M71, M72, INCH or METRIC, they will of course override any settings from this dialog. 

This is useful for importing files which have the header and the rest of the data in different units, such as 

diameters in metric and coordinates in English or vice-versa. 

• D Code rotation 

The operation to rotate a group of D Codes, available in the “Setup/D Codes” (F5) table, has been changed to 

allow for a user specified angle of rotation. Previously only a rotation of 90 degrees was available. The command 

is now “Operations/Rotate” (was “Operations/Rotate 90 Degrees”). 

• “View/Distance/Edge To Edge” 

Has been changed from a command to a tool. See description under “Distance Measurement” in the “New” 

section below. 

• “View/Coordinates Origin/Set Relative Origin” 

This command has been renamed “Relative Origin Tool” and has lost its shortcut (Shift+R) now linked to a new 

command that sets the relative origin but is not a tool (immediate action). See below under “New” commands. 

• “File/Import/Gerber/Options” 

The “Data Format” tab items “Left of decimal” and “Right of decimal” are selectively grayed out to convey to the 

user when they are irrelevant. “Left” is irrelevant in “Leading” omit zeros mode and “Right” is irrelevant in 

“Trailing”. 

• “File/Import/Guess” 

The Import Guess results dialog has changed for setting m and n.  It now uses two buttons to shift the decimal 

point instead of dropdown boxes.  Also the “Apply” button has been removed as the board size is automatically 

recalculated whenever a parameter is changed. 

• “File/Import/Apertures” 

When importing Pads aperture files, German headers will be recognized.  Also the units will default to mm. 

•  “File/Import/ODB++” 

 The ODB++ layer name value will be used during import to set the layer name in the F10 menu. 

 ODB++ will now tag the first copper layer as CPU, last copper layer as CPL.  Any layers before the CPU that 

are silk, soldermask, or solderpaste will be marked as ‘U’pper.  If these files are listed the CPU layer, they 

will be marked as ‘L’ower.  Drill layers are now DRI instead of PAD.  

New features 9.6.91: 

• “View/Visibility/Layer/Board #0 Always Visible” 

A new option for controlling the behavior of the commands that step the visibility of layers. These are in 
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“View/Visibility/Layer”:  “Next Layer”, “Previous Layer, “Next Board Layer” and “Previous Board Layer”. 

When “Board #0 Always Visible” is checked, then these commands will always cause board layer #0 to stay on 

(visible) together with the next board layer in the sequence (next or previous). 

•  “Edit/Edit Selection/Polygons/Make Well Formed” 

The algorithm has been improved to handle a larger variety of malformed polygons. 

• “Select/Duplicate Active Elements” 

Elements that have no width will now be processed by this command also. Previously they were ignored. This 

includes pads and traces mapped to D Codes that have zero width or of shape type “F”. 

• “File/Import/DPF” 

Now uses the Windows temp directory for temporary files during import. 

New features 9.6.81: 

•  “File -> Import -> Apertures” 

A new aperture type, Proteus.inf files, are now supported. 

•  “File -> Import -> Directory/ Zip” 

A new button has been added to the scan results dialog, “ReScan”.  When pressed, the user can change the import 

option settings and rescan the files.  In the past the user had to start the import over from the beginning. 

New features 9.6.78: 

•  “Edit -> Edit Selection -> Special -> Convert Routing Paths To Traces” 

This command replaces the selected routing paths with traces, one trace per edge. Previously this command was 

available only in CAMMaster (and higher) as “Tools -> Routing -> Ungroup To Traces”. 

•  “File -> Import -> Apertures” 

ApSource7 now imports diamonds. 

• “File -> Import -> ODB++” 

Import time has been greatly improved. 

New features 9.6.69: 

• Drag The View Using Scrollbars 

When “View->Preferences->Drag View In Real Time” is checked, dragging the scrollbar boxes will also drag the 

view in real time. Note that the “Drag View In Real Time” also controls the behavior of dragging the view with 

Ctrl+Alt+Left Mouse button (this was present in previous versions also). 

•  “Setup->Tool Codes” (Shift+F5) 

A new command has been added for transcoding tool numbers. It is called “Transcode Selected” and will 

transcode all the selected tools (which can be contiguous or not) to a contiguous range of tool numbers specified 

by the user. Of course one can transcode just one tool number, for instance T4 to T9, but also sets like T1, T4, T7 to 

start at T10, which will cause the transcoding: T1->T10, T4->T11 and T7->T12. 

• “File->Import->”From Layers”  Uses Cur Dir” 

A new setting which applies only to the command “File->Import->From Layers”. This command imports several 

files using the layer names as file names. For names that are not full paths, it is not obvious how to complete the 
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path (which directory they are in). Previously the directory was assumed to be the directory of the jobfile. When 

this new option (“From Layers” Uses Cur Dir) is checked, the “current directory” is used instead. The current 

directory is an operating system dependent concept and it is changed when file browsing dialogs are used. It is 

usually the last place where a file was saved/exported or opened/imported. 

• “Paint And Scratch->Expose Scratch” 

Command available in the context menus in the layer toolbar and layer setup dialog (F10). Will correct layers that 

start with scratch elements (which are invisible). It will add a covering paint rectangle in front of them so as to 

expose the scratch elements. 

New features 9.6.53: 

• Layers Toolbar 

A new way to quickly turn on or off a range of layers has been added. 

This is done by clicking the right mouse button and pressing either the Shift or Control keys at the same time. If 

neither of these keys are pressed, then the normal context menu is displayed. However, if any of these keys is 

pressed, this action will cause instead to change the visibility of the layers ranging from the current layer to the 

layer on which the right button is clicked. Shift will cause the range to be made visible, Control will cause the 

range to be made invisible. 

New features 9.6.43: 

•  “File/Import/Drill & Rout” 

A new option has been added for importing Excellon files. It is in the “Options” tab of the “Options” dialog. It is 

called “M00” and controls how M00 statements are interpreted. 

There are three possibilities: 

− “Treat as end of program”. This will cause the current program to be terminated and any following data 

will appear on a new layer. 

− “Ignore”. The statement will be completely ignored. 

− “Increment tool”. The statement is interpreted as a tool change to the next sequential tool number. 

• Crash Report Generation 

If the software crashes, a dialog will come up asking whether to email a crash report to PentaLogix technical 

support. These reports will be investigated by technical support and they help to find and fix the source of the 

problem. 

• ”File/Import/Aperture” 

A new aperture type “Metric Source” has been added.  This aperture type recognizes files that use commas 

instead of decimal points and has special conversions for an aperture named “SYMB” to targets. 

• “File/Import/Guess” (also, Directory and Zip) 

Gerber extended (RS-274X) files with incorrect format statements (FS) are now easier to import. 

Hard to believe, but some Gerber files have format statements which are incorrect. Previously the only way to 

correct this was to edit the file and change or remove the statement. 

Now one can use “Import/Guess” (or “Zip” or “Directory”) which will guess the format and will allow the user to 

override it in the dialog that appears (checkbox item “Override parameters”). 

• Pads / Traces Contrast 

Contrasting pads and traces with different colors in the same layer is not guaranteed to display correctly when 

the board layer contains paint and scratch. However, certain users need this feature so much that they would 

rather use it on such layers also, even if the display is not guaranteed to be correct. 



©PentaLogix Inc., 1985-2025.  All rights reserved Page 46 of 80 

This version enables them to do so, by checking the option “Allow contrast on paint/scratch also” in 

“View/Visibility/Element/Options”. This is a “use at your own risk” kind of option. The data will always be 

correct, but the paint/scratch rendering may be incorrect when pads contrast is on. 

• “Edit/Paint And Scratch/Optimize Selection” 

The optimization operation has been improved to pair scratch and paint polygons. Polygons with holes are often 

represented via paint and scratch because some of the import languages do not have ways of representing 

polygons with holes directly. Gerber is such an example where holes are represented as scratch polygons. 

The optimization operation will now detect such situations and add the scratch polygons as holes of the 

corresponding paint polygons. This results in fewer scratch elements and sometimes in the complete elimination 

of scratch elements. 

• “File/Import/Apertures” 

If the aperture import encounters problems, an error file is generated.  When the dialog box appears to report that 

errors have been encountered, a button has been added to view the error file. 

• NC Tool Sizes 

Tool sizes are now saved in jobfiles (binfiles) even if they are not mapped to any D Codes. This facilitates using 

common setups of NC tools. One can set up the tools, then save an empty (no circuit data) binfile, which can later 

be opened or imported to restore the settings. 

New features 9.6.17: 

• “File/Import/Gerber/Options/RS274-X Options” 

 The handling of “IPNEG” commands has been improved. 

These are used to define a layer as a negative layer. “IP” stands for “Image Polarity”. The issue is how to 

treat subsequent “LP” commands (“Layer Polarity”). These can be “LPD” or “LPC”. Some files assume 

“LPD” to be the paint polarity, some “LPC” (“LPC” seems to be more prevalent). 

Previously there were only two modes for this option. Now a third one, called “Automatic” has been added 

that will try to guess the correct setting. 

New features 9.6: 

• “Edit/Move Layers/Align Visible Layers” (Ctrl+Q) 

A new command to facilitate aligning layers has been added. It incorporates the methods that were available in 

the old “Edit/Move Layers/Align” (which it replaces) and it adds more methods. 

This command works on all visible layers and will try to move some of them so they align with the others. The 

following methods are available: 

1) Pad or trace in a corner of a layer. The corner to be considered can be specified by the user (upper-right, 

lower-right, upper-left or lower-left). The software will pick (in each visible layer) the element (pad or 

trace) closest to the corner in that layer and will use them as reference elements. The layers will be moved 

so that the reference elements end up on top of each other. 

2) One selected element in each layer. The selected elements will be used as references in each layers. The 

layers will be moved so that the selected elements end up on top of each other. If more than one selected 

element exists in a layer, an error will be reported and the operation aborts. Layers which have no 

selected elements will be ignored. To select elements, one can use the selection tool (S) or simply double 

click on an element. Remember that to add to an existing selection one needs to keep the Shift key 

pressed while selecting. 

3) One selected pad whose type is used as a guide. This is the old “Edit/Move Layers/Align” that has been 
around for quite a while. It requires the selection to consist of just one pad. If pads similar to it (using the 
additional rules of “D Code Number Only”, “Shape Type Only” or “Shape Type And Size”) are found in 
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the other layers, the closest to the selected one is picked in each layer and used as the reference for that 
layer. The layers are then moved so that all these pads end up on top of each other. 

This works well only for cases where the layers are not offset by much and there are distinguished pads 

(such as targets). If all layers have targets, aligning targets is an easy way to do the job. 

In each of these cases some layers will be moved and others not. One layer (at least) is always left where it is. For 

method (3), that layer is the layer that contains the selected element. For methods (1) and (2), the largest number 

of layers that already match are left standing. If no layers match already or the operation is done on only two 

layers, then the “current layer” is left standing. 

For many cases more that one method needs to be used. Pads can very often be used for alignment, but some 

layers have no pads (such as silkscreen layers) and so a second step to align them may be necessary (using traces, 

or selected elements). 

• “File/Import/Drill & Rout” 

Added support for importing Excellon commands G32 and G33 (“Routing Circle Canned Cycle”) and Sieb & 

Meyer commands G45, G46 (“Rout A Hole”), G47, G48 (“Rout A Round Card”) and G49, G50 (“Rout a Hole 

(Rectangle)”). 

• “Setup/D Codes” (F5) 

A new command for selecting elements mapped to a set of D Codes. It is in the menu of the “D Code Table” 

dialog under “Operations/Select Pads And Traces”. For all the picked D Codes in the table (which are highlighted 

in dark blue) the elements mapped to those D Codes, and in visible layers, will be selected. This allows selecting 

elements mapped to more than one D Code.  

• “Setup/Preferences/Only One Tool Can Be Active” 

This is a new preference, but it modifies a behavior that existed previously. Certain user tools: zoom 

(“View/Zoom/Tool” (Z)), select (“Select/Selection Tool” (S)), distance (“View/Distance” (D)) and others are 

considered “helper” tools in the sense that it is sometimes useful to activate them while another (perhaps multi-

step) tool is active (in dormant state). When the helper tool is canceled (by Escape or otherwise) the dormant main 

tool is reactivated. 

Some users do not want this behavior, because they would rather have just one tool active. For those user, this 

new option has been introduced. When checked and a helper operation is activated, any previous operation is 

canceled. 

• “File/Import/ODB++” 

 Improved import algorithm is much faster. 

 The import process has been streamlined by importing according to the ODB matrix rather than requiring 

the user to select import order.   

 Step and repeat, rotations, and offsets are now imported correctly.  

 The profile step is now imported as a BOL type. 

 When running in Batch mode, all menus are suppressed. 

• “File/Import/DPF”  

When importing files in metric, the conversion is now much more accurate by using a conversion factor to eight 

decimal places. 

• Selection Toolbar 

There are several new options to specify elements to select or pick (in the dropdown list): 

  “Open Paths”: picks open routing paths only. 

  “Closed Paths”: picks closed routing paths only 

 “No Lead-In”: picks closed routing paths which have no lead-in 

 “Net Midpoints”: picks elements which have a net number (or name) and have been marked as net 

midpoints by a previous net import or net extract operation. 
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 “Net Endpoints”: picks elements which have a net number (or name) and have not been marked as net 

midpoints by a previous net import or net extract operation. 

•  “Edit/Break Traces And Clip Polygons” (Ctrl+B) 

This command was called “Break Traces” before. Now polygons are included in the operation also (when a frame 

is used for clipping). Any polygons that touch the frame will be clipped by it and subdivided into several 

polygons, similar to the way a trace is clipped. This provides a powerful new way to manipulate polygons. 

Note that this operation is affected by the state of the “Inside” button on the “Selection” toolbar. 

•  “File/Import/Gerber” 

 The settings in a Gerber extended “FS” statement (Format Statement) will not change the user settings in 

File/Import/Gerber/Options. They will of course apply to the current plot, but will not affect later files. This 

allows the values set by the user to persist. 

 Improved handling of approximate arcs (when the radius at one endpoint is different from the radius at the 

other endpoint). 

 The “AM” Rotation modes for “Rotate around” have been expanded to three. Previously there was “Rotate 

around center of each primitive” and “Rotate around aperture center”. Now a new mode has been added, 

called “Automatic”. This will pick one of the two previous modes, depending on the type of primitive.  

This has been determined after examining a number of sample file, some of which needed both types of 

rotation in the same file. 

The auto mode seems to be working well with all the sample files examined, but the other two modes have 

been left in the user interface as a fallback position, to account for different types of Gerber files that the user 

may encounter. 

• “View/Distance” 

The distance measurement tools now display the current distance next to the cursor in the main view, in addition 

to the X box in the “Screen” toolbar. 

• “File/Import/Guess-Directory” 

 The import options now has checkboxes to include/ exclude certain file types. The file types are: 

− Scan for Data Files 

− Scan for Aperture files. 

− Scan for Netlist files 

 The default import order has been changed.  Drill files are placed near the bottom of the list; and drill files 

with tool definitions but no data, immediately precede the drill files.  Netlist files are placed last.  This is to 

accommodate net lists with ‘T’ codes. 

 Certain file types are filtered from scanning to prevent crashes.  Files ending in “PDF”, “DWG”, and DXF” 

are ignored.  Other files are scanned to detect binary data and will be ignored if appropriate. 

 Zip now has the same options button found in import directory. 

 Tap files without format data will default to the most common parameters.  This file format will now be 

identified as three possible types: 

− Tap definitions without tool changes will be treated as an aperture file, no drill data imported. 

− Tap files with Excellon tool definitions will be treated as Excellon drill files. 

− TAP files with TAP tool definitions and with tool changes will be identified as a new type, NC_TAP.  

Tool definitions and data imported. 

 Imports both the tool and drill data if present.  The file type is called “NC-TAP/ Excellon”.  When the format 

isn’t provided, default settings will be used that seem to work in most cases. 

 Recognition of Excellon format improved handling of ‘T’, ‘F’, ‘C’, ‘S’ commands.  Metric 1, 2, formats 

recognized. 

 Gerber files with large AM (Aperture Macros) import quicker. 
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• “File/Import/Apertures” 

 Valor aperture files now import diamonds, thermals, obrounds, and octagons. 

 LAV501 apertures now supports octagons and tool definitions. 

• “Help/Check For Updates” 

The user can now specify an interval of time for automatically checking for software updates from the PentaLogix 

website. This check will be done in the background and the user will only be notified if there is a new version 

available. 

New features 9.4.73 

• Unmapped D Codes 

Unmapped D Codes (of shape type “?”) and N type D Codes for which the corresponding tools are unmapped (of 

type “?”) will be displayed as a question mark inside a doughnut. This is to make them easy to recognize when 

looking at the display. Previously they were displayed as rounds. 

New features 9.4.6 - 65 

• “File/Import/Discard Path In Layer Names” 

Controls how layers are named from file names during import operations. 

When checked, only the file name part will be stored as the layer name and the path part of the file name will be 

discarded. 

When unchecked, the hole path name will be used, unless the file is in the same directory as the currently loaded 

jobfile. 

• “Setup/Visibility and Display” 

“Step & Repeat Blocks”. New options have been added for the display of step and repeat blocks. The two 

options are “Display all details” and “Display outlines only”. The new one is the second option. If selected, it will 

cause all step and repeated data to be displayed on the screen as a boxes, without the detail of the circuit elements 

inside. This saves time when examining large panels with a lot of panelized data. Note that this applies only to 

“blocked” step and repeat data. If the data was step and repeated using copying, this option does not apply, as 

the step and repeat information is not recorded in the database. 

• “Setup/Layers” (F10) 

New commands to save/restore the default color setup for layers display. The commands are available from the 

context menu (right mouse click) under “Colors Setup”. There are three commands: 

 “Save Current As Default”: the current setup of layer colors and color definitions (RGB content of colors) 

becomes the default. The next time the software is started, it will display these settings as the default. 

 “Restore From Default”: layers colors will be set to the default settings. 

 “Restore From Factory Settings”: layers colors will be set to the PentaLogix default values. 

• “Edit/Edit Selection/Move By Displacement” 

A new command to move the selection by user specified X and Y displacement values. 

• “Insert/Pad” 

During the insert operation an outline of the shape to be inserted is dragged along with the cursor, giving better 

feedback as to what the result will be. This includes outlines of complex shapes also. 

•  “View/Distance” 

The distance measurement tools (“From Point (D)” and “From Edge”) now stay active until explicitly canceled. So 

they will stay active when starting other tools, such as the insert trace and pad tools. This is useful for accurate 
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positioning during such insert operations. 

• Pad outline mode (O) 

Custom apertures (shapes of type M) will be showed outlined with primitives displayed individually (both paint 

and scratch primitives are shown). This allows for a better understanding of the components of a custom shape. 

•  “File/Import” 

 “Gerber” 

“AM” rotation. It has been determined that both interpretation for the rotation of AM apertures exist in 

Gerber files. The two possibilities are: 

- rotate each primitive individually around its center or 

- rotate the whole aperture (around the aperture center) 

In versions previous to 9.4, the second method was used, then in the early 9.4 releases it was change to the 

first method. We have now seen files that assume one or the other, so the decision was made to add a user 

setting, so the user can pick which one to use. It is in “Options/RS274-X Options” and it is called “Rotate 

around”. 

 “Bitmap” 

Better handling of color bitmaps based with a color palette. 

  “Directory/ Zip/ Guess” 

Recognition of Excellon format has been improved.   

The Excellon format statements Metric 1-3 is now recognized.   

Adobe Acrobat .PDF, Illustrator .AI, AutoCAD .DXF and certain .DSN files will be ignored for import. 

The import order has been changed.  Netlist files will be listed last.  Drill files will be listed before the Netlist 

files.  If a drill file does not contain coordinate data, it will be the first drill file listed.  These changes will help 

drill sizes to be properly imported. 

  “ODB” 

ODB import is now much faster.  Step and Repeat as well as rotate is now handled properly.  Profile layer is 

now imported as BOL.  The menu to arraign layer order has been eliminated.  The layers will now import in 

the order defined by the ODB file. 

•  “Setup/D Codes/Operations/Unique Shapes” 

A new option has been added called “Shape types to consolidate”. This allows handling N-type shapes 

differently. One can apply the operation only to N-type shapes, only to non-N type shapes or to all shapes. 

New features 9.4.1: 

• “File/Import/Bitmap” 

ViewMate will now import bitmap files.  This feature has been available in the higher PentaLogix products for 
some time.  It is now being made available in the free version as well. 

• Pad outline mode (O) 

Custom apertures (shapes of type M) will be showed outlined with primitives displayed individually (both paint 

and scratch primitives are shown). This allows for a better understanding of the components of a custom shape. 

• “View/ Distance” 

The distance measurement tools (“From Point (D)” and “From Edge”) now stay active until explicitly canceled. So 
they will stay active when starting other tools, such as the insert trace and pad tools. This is useful for accurate 
positioning during such insert operations. 

• “Insert/ Pad” 

During the insert operation an outline of the shape to be inserted is dragged along with the cursor, giving better 
feedback as to what the result will be. This includes outlines of complex shapes also. 
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New features 9.4: 

• “File/Import” 

 “Gerber” 

The extended Gerber command “IR’ (Image Rotation) is now supported. 

 “Drill & Rout” 

Sieb & Meyer rout data is now supported. Previously only drill data was supported for Sieb & Meyer. 

 “Directory” 

Import a complete directory of files is a powerful feature that has been in higher PentaLogix products for 

many years.  This feature is now available in ViewMate as well.  The accelerator key (shortcut) is: Ctrl+F4. 

•  “Insert/Arrow” 

A tool to insert arrows made out of traces, similar to the arrows generated by “Insert/Dimension”, except that 

there is no dimensioning. These arrows can be used to mark locations of interest. The height of the arrow is 

derived from the “Text Height” parameter in the “Inset/Loc and Dim Setup” dialog, similar to the 

“Insert/Dimension” tool. Once the tool is active, you need to click first at the position of the head of the arrow and 

then at the position of the tail of the arrow. 

• “Select Layers” 

A new command to select all elements in a group of layers, specified as a comma-separated list of layer ranges (for 

instance “3-5, 12, 14-22”). This will make a new selection, any previously selected elements will be deselected first. 

•  “Setup” 

 “Remember Directory for Import” has been replaced with “Remember Directories”. When checked, separate 

directory names are remembered for import, export and macros. 

  “D Codes” (F5 dialog) 

− The dialog has been redesigned to allow for column resizing. One can do this in the usual way by 

dragging the gridline that separates two headings in the headings row, for instance between “X” and 

“Y”. 

− One can sort the table by values in a given column. This can be done by clicking on the heading of the 

column. For instance, clicking on “X” will sort the table by the X dimension of the D Codes (ascending or 

descending). 

− The dimensions of the D Code (in the X and Y columns) are displayed at their highest accuracy. 

Previously, only 6 digits were displayed and the value was rounded if it needed more that 6 digits 

(including the decimal point). 

− The shape of the current D Code is displayed in the dialog. 

− The whole table can now be printed: “Operations/Print”. 

− The “similar shapes consolidation” command “Operations/Unique Shapes” will now consolidate two D 

Codes of N-type that are mapped to different tool codes but the same diameter. 

•  “View” 

 “Visibility/Layer/Toggle Layers”: 

A comma separated list of layers or layer ranges can now be entered. Previously only a single layer could be 

toggled. 

• “Insert/Loc and Dim Setup” 

A new option has been added for the “Insert/Location” and “Insert/Dimension” tools: “Append Units”. When 

checked the text for the units (“inch”, “mm”, etc.) will appear after the dimension number, otherwise only the 

number will appear by itself. Previously the text for the units was always present. 
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• “File/Import” 

 “ODB++” 

− The net information will now also be imported, if present in the ODB file.  If multiple netlists are 

available, the user will be prompted to choose the appropriate netlist 

− PentaLogix layer type recognition has been improved 

− ODB can now be imported with messages suppressed for batch mode operations 

 “DPF” 

− TEXT commands are now handled. 

− Nested blocks now supported.  Rotations, scaling, etc. are supported. 

 “Apertures” 

Added a new GAPFile type.  Supports the following string types: 

!GAPFile Version 3.0 

11 Round d:8.0 

309 Oblong w:13.0 h:48.0 a:0.00 

310 Rectangle Sq w:84.0 h:76.0 a:0.00 

New features 9.2.41: 

• “File/Print” 

The print dialog has two new items: a “Font” button and a “Raster” checkbox. 

“Font” allows selection of the font for the header. Previously a default font was used and will still be used if no 

new font is picked. 

“Raster” picks which printing method is used: raster bitmap based or Windows GDI based. Note that for 

Windows ME and lower only the raster method is available. For the other Windows versions the user can pick the 

preferred method. The Windows GDI based method is faster and works with all printers, whereas the raster 

method (which sends a potentially large raster bitmap to the printer) is more similar to the screen display (in 

color mode) as translucency of colors is supported (although the colors may be different on screen and on the 

printer). 

• Import Apertures/ Netlists 

In any dialog where the user has the option to view a file, the users’ defined viewer will be used.  If the file type 

doesn’t have a viewer assigned, wordpad.exe will be used.  

New features 9.2.27: 

• “File/Import/ODB++” 

 By selecting “From Dir”, the user can now import ODB jobs directly from the directory without having to create 

a TGZ or TAR file. 

• “Edit/Edit Selection/Polygons/Separate Holes” 

The holes that result from the separation will be selected, whereas the containers will be unselected. This makes it 

easy to further process holes if desired. Previously both the holes and the containers where selected. 

New features 9.2.2: 

• “Select/Duplicates” 

Looks for duplicates among the currently selected elements. Only the duplicates will remain selected while all the 

other elements are deselected. Duplicates are elements that are geometrically identical and in the same spot (on 

top of each other) and of the same shape (although not necessarily the same D Code). Currently only pads and 

traces are checked for duplicates (polygons and routing paths are not). 
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• “Edit/Edit Selection/Special/Merge Colinear Traces” 

Looks for linear traces in selection that continue each other and are collinear (on the same line) and replaces them 

with one trace which spans the whole extension. 

• Layers toolbar context menu (right-click) 

Five more commands have been added under “Select”: “All”, “Traces”, “Pads”, “Polygons” and “Routing Paths”. 

These commands will select only elements from the layer that was picked and the selection is made independent 

of the other criteria (the “Only” buttons etc.) as well as independent of element visibility. It is always a “new” 

selection, meaning that all other previously selected elements will be deselected. The previously existing 

commands “New”,  “Add” and “Remove” are preserved and work the same way as before (they are affected by 

the normal selection criteria. 

The new commands give a quick way of selecting a whole layer or just some particular element type within a 

layer without worrying about the other settings in the software. 

New features 9.2: 

• Paint elements and scratch elements can now coexist in the same layer. 

Previously a layer was paint or scratch and all elements inside were of the same polarity (paint or scratch). 

However, because some import files contained many polarity switches (from paint to scratch and from scratch to 

paint) each requiring a new layer, the result was a large number of layers. It could even happen that the 

maximum number of 255 layers was exceeded and so the file could not be imported. Starting with this version, a 

polarity change in the input will not require a layer change as paint and scratch elements can now coexist in the 

same layer. 

To see how many polarity changes there are in a layer, make that layer the current layer and then do 

“File/Properties” or Alt+Enter. The number of polarity changes is one of the information lines in the displayed 

dialog. Multi-polarity layers are also marked with a ‘+’ in the layers toolbar (instead of the ‘*’ for a single polarity 

layer). 

One can still set the polarity of a whole layer as paint or scratch (same as before). If the whole layer polarity is 

scratch then the polarity of elements inside will be reversed: paint elements will act like scratch and scratch 

elements will act like paint. 

A layer which contains both paint and scratch elements can be separated into an equivalent sequence of layers 

which contain only one polarity. This makes it easier to edit the data (if necessary) and also conforms to how the 

software acted in previous releases (for users who prefer it that way). Note that for each polarity switch an extra 

layer is required. This can be done using commands in the “Paint And Scratch” submenu which appears in 

several places: 

 in the main menu under “Edit” 

 in the layers toolbar context menu (right-click of mouse) 

 in the Layers Table dialog (F10) context menu. 

There are two commands for separation: 

 “Separate Current Layer” 

 “Separate All”. This separates all layers that have mixed polarity. Note that for users who prefer the old way 

of storing paint and scratch, the operation to do is “Separate All” after each import. 

The reverse operation also exists, to combine a sequence of layers which belong to the same board layer (and 

perhaps have different polarities) into one layer. Commands for this are in the same “Paint And Scratch” 

submenus: 

 “Combine Layers” 

 “Combine All”. This looks for adjacent layers that belong to the same board layer (and are visible) and 

combines them into one layer. The operation is then repeated for all the layers in the job. 

The only way to change the polarity of elements is by setting the layer polarity. So if one needs to change the 

polarity of only a group of elements inside a layer, one needs to transfer them to an empty layer immediately 

following the layer in question, set the board layer number to be the same, then change the layer polarity to the 

desired value and finally combine the two layers into one layer again. 
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A new version of binfiles is also introduced with this version (V10 of binfiles). This is only needed when saving 

jobs that have mixed polarity elements in the same layer. Note that older versions of the software will not be able 

to read/open these binfiles. 

The “Paint And Scratch” menu under “Edit” has one more command that acts on the selected elements only: 

“Optimize Selection”. This command will examine the selection, layer by layer, and within each layer will 

attempt to reduce the number of polarity switches. Sometimes input files contain a lot of polarity switches that 

are unnecessary because later paint and scratch elements do not interact (overlap) with previous ones, so it is 

possible to merge them into fewer polarity groupings. This can be useful when one needs to edit the data and also 

makes the export/output more efficient. 

•  “Insert/Chamfer” 

Activates a tool to insert, move (slide) or delete a chamfer trace. This tool is a combination insert and edit tool. 

While the tool is active, pressing “Shift” puts it in the insert mode, while pressing “Ctrl” puts it in the remove 

mode. If none of the keys are pressed, it is in edit (move) mode. 

A chamfer trace is a trace connected at both endpoints to other linear traces which act as “rails”. The chamfer can 

be moved parallel to itself while being guided by the rails. It can be a linear trace or an arc trace. In the 

edit/remove mode this is determined by what trace is picked for editing, in the insert mode this is determined by 

“Insert/Arc Chamfer Mode” (once set, it will be remembered for future operations). 

Note that when picking (either the chamfer to edit, or the junction of the rails where to insert) only active 

elements will be considered (this means all the “Only” buttons are active). 

The insert operation will create a new chamfer starting at the joint of the two rails, while the remove operation 

will delete an existing chamfer and extend the rails so that they meet. 

These operations can be used to rearrange circuits so that they provide more clearance spaces where needed. 

• “Edit/Edit Traces” 

A new group of operations to edit traces. They affect up to three traces at a time. The traces can be straight (linear) 

or arc traces. The following table provides a summary of the operations. 
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Name Of 
Operation 

Action Traces 
affected 

Move Trace Picks closest trace. The trace then follows the cursor by moving 
parallel to itself. 

1 

Move Endpoint Same as “Move Trace”, but operation starts by picking trace at 
closest endpoint only. 

1 

Move Vertex Picks closest junction (vertex) of two traces. Both traces then follow 
the mouse by moving parallel to themselves and staying connected. 

2 

Move Chamfer Picks closest trace. Each endpoint of the trace needs to be connected 
to another trace. All three traces then follow the cursor by moving 
parallel to themselves (as a group). 

3 

Drag Trace Picks closest trace and traces connected to each of its endpoints. The 
picked trace follows the cursor by moving parallel to itself while the 
connected traces will be stretched (the other endpoints of the 
connected traces will stay unchanged). 

3 

Drag Endpoint Picks the closest trace endpoint. The endpoint then follows the 
cursor while the trace is stretched (the other endpoint stays 
unchanged). NOTE: this is the same as the older “Edit/Stretch 
Traces”. 

1 

Drag Vertex Picks closest junction (vertex) of two traces. This vertex then follows 
the cursor while the traces are stretched (the other endpoints stay 
unchanged). 

2 

Drag Chamfer Picks the closest trace and the two guiding rails attached to each 
endpoint. The trace then follow the cursor while guided by the rails. 
NOTE: this is similar to the “Insert/Chamfer” tool in edit mode. 

3 

 

The shortcut key for the whole group of commands is F8. Pressing F8 will activate (or cancel) the last used “Edit 

Traces” command. Pressing Shift+F8 and Ctrl+F8 will step to the next  or previous tool (up or down through the 

menu listing). 

• Viewing of selected elements 

Two new ways of visualizing selected elements have been added to the two that existed. They can be picked from 

“View/Visibility/Selected”, “Setup/Visibility” or the Visibility Toolbar. 

The four modes are: 

Mode Name Color For Unselected Color For Selected 

Display In White Layer color Bright white 

Display In Contrasting Color Layer color Color that contrasts with layer color 

Display By Dimming Unselected Dimmed layer color Layer color 

Display Unselected In Gray Dark gray Layer color 

 

The last two modes are the new ones. In both of these modes the selected elements are displayed in the layer color 

(both traces and pads, even if contrast is turned on). This is meant to help in cases where the continuity of the 

selected elements across layers is important to visualize, such as when examining netlists. In the last mode the 

unselected are displayed in one color independent of what layer they belong to. This color defaults to dark gray 

but can be set by the user to any other color using the “Set Layer Color” dialog that can be reached from several 

places (“Setup/Colors”, right-click on the Layers Toolbar or from the “Setup/Layers” dialog). 

• “Edit/Edit Selection” 

 “Special/Replace M-Type Pads With Primitives” 

This is a new command which works on the selection. It will replace all pads in the selection that are of shape M 

(Custom) with the primitives that make up the shape. The result will look exactly the same, but will contain no 

custom shapes. This can be useful when data needs to be exported to devices (or software) that have trouble 

understanding custom shapes (photoplotters etc.). 

A similar command already existed in the software, but was only accessible from the D Code Table (F5) and did 
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not act on the selection, but rather on the D Codes that were picked from the table.  

That command was “Custom Apertures/Replace With Primitives” and is still there in this version as well. It has 

been improved to handle custom shapes that contain scratch primitives. Previously such shapes were not 

processed. Now, these shapes are converted to polygons and then the pads are replaced with these polygons. 

“Replace M-Type Pads With Primitives” works the same way: shapes with scratch primitives are replaced with 

polygons and shapes without scratch primitives are replaces with the constituent primitives (pads, traces, 

polygons).  

• “File/Import/Drill & Rout”: 

Support for FMAT command in Excellon program header.  

•  “Setup”: 

 “Layers” (F10) Context Menu: a new command has been added – “Compact”. The purpose of this command 

is to eliminate any empty layers from within the sequence of layers in a job. Layers will be transferred so that 

the relative layer order is the same, but there are no intervening empty layers. 

 “Visibility: 

All the global visibility settings for elements have been assembled into this dialog. All these items exist as 

other menu entries or dialogs, under “View/Visibility/…” but have been assembled here for quick access. 

 “Colors” 

 To set the color of the current layer. 

New features 9.0.50: 

• For the context menu (the right-click menu over the view) 

the most recently used command will appear as the first entry of the context menu, to facilitate repeating the 

same command. 

• “Edit/Edit Selection/Arcs/Break Into Quadrants” 

same as “Tools/Convert Arcs/Break Into Quadrants”, but works on selected arcs. 

• “File/Import/Drill & Rout”: 

“Options/Options”: new options added for importing Excellon files. 

The purpose of this new option is to specify the user desired handling for the “Block Delete” command (the slash 

(“/”)) at the start of a  block. There are now three possibilities in the new “Block Delete” box: 

(1) Follow BLKD command: the BLKD command in the header of the file will specify whether blocks marked 

with slash will be read in or ignored. The two forms of the BLKD command are “BLKD,ON” and “BLKD,OFF”. 

(2) Read in always: BLKD commands in the header are ignored and blocks marked with slash are always 

imported. 

(3) Delete always: BLKD commands in the header are ignored and blocks marked with slash are always deleted 

(ignored). 

Note that the last two options will override any BLKD setting in the header of the Excellon file. 

New features 9.0: 

• A new layer type has been added 

The new type is a generic plane layer type. Previously there were five power layer types (PW1-PW5) and five 

ground layer types (GD1-GD5). In addition to these, there are now 99 generic plane layer types (P01-P99). They 

can be used for netlist extraction for either ground or power plane layers. 

• A new navigation aid has been added 

One can now drag the view by dragging the mouse (with the left button pressed) while both the Ctrl and Alt keys 
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are pressed. Since redraw times can be long when a lot of data is loaded, the drag can be done in real time or not. 

This real time feature can be enabled or disabled via “Setup/Preferences/Drag View In Real Time” or 

“View/Preferences/Drag View In Real Time”. 

• Commas as decimal separators 

In the case of numbers typed into dialogs: commas can now be used as decimal separators (as well as points) to 

facilitate data entry in countries where the point is not the decimal separator. So the numbers “1.2345” and 

“1,2345” will be considered the same. 

• “File/Import”: 

 “Guess”: a new command for importing files of unknown type or format. The software will attempt to guess 

the type (Gerber, DPF, Excellon, netlist, etc.) and (where applicable) the format (Leading/Trailing etc.). The 

file is then imported into the current layer. 

 “Aperture”: the wizard now has an additional radio button: “TCodes”.  When selected, only a tool code and 

a drill size need be identified. The wizard will translate the codes into Tool codes rather than D codes. 

• “Insert/Text” 

 A new checkbox has been added to the “Add Text” dialog called “Grouped”. This will determine whether 

the newly inserted text will be grouped or ungrouped. It was done so that users who prefer the old 

(ungrouped) way of storing text do not need to do an “ungroup” after the text is inserted (one can always do 

an “ungroup” after the fact using “Edit/Edit Selection/Text/Ungroup”). 

 A new font has been added: ODB Standard. 

• “Edit”: 

 “Edit Selection/Replace Arcs With Chords ” 

 Same as “Tools/Convert Arcs/Approximate By Chords” but works on the selected elements only. Note that 

the “Tools…” function works on all active elements that are inside the frame.  

  “Step And Repeat”: A new way to load the step distance. There is now a button to the right of the Step X 

and Y fields (labeled “<”). When pressed it will load the step fields from the current values of the X and Y 

boxes in the “Screen” toolbar. Most useful when the display is in relative mode or distance measurement 

mode. 

•  “Setup”: 

 “Preferences”: 

− “Drag View In Real Time”: see the “drag the view” item above. 

− “Ignore Preferences From Jobfiles”: affects the processing of user preferences and parameters when job 

files (binfiles) are opened. When checked, these preferences will be ignored (the data in the job files is of 

course read in). Some users prefer to have the preferences set a certain way and do not want them 

changed by opening a job file. One example of a set of such preferences are the Gerber import options 

(from “File/Import/Gerber/Options”). 

 “D Codes”: a new command to quickly go to the first unused D Code following the current D Code 

(“Goto/Next Unused”). 

 “Frame/Visible”: command to turn frame visibility on or off. 

 “Advanced/Intensity Contrast By RGB”: this defines how the color intensity contrast is done for the 

following commands: “View/Visibility/Element/Options/Show Pad-to-Trace Contrast As Contrasting 

Intensity” and “View/Visibility/Selected/Display In Contrasting Intensity”: 

− When unchecked, the contrasting color is taken from the table of fifteen defined colors. The table is 

conceptually divided in two halves, where the lower half (colors 1-7) is usually the “low intensity” half 

and the upper half (colors 8-15) is usually the “high intensity” half. The contrasting color will be the 

corresponding spot in the other half (so 1 and 9 are contrasting, 2 and 10 etc). 

Note that the actual colors in the table of 15 can be redefined by the user in an arbitrary fashion, so the 

two halves may not really reflect the “low intensity”/”high intensity” division, but the contrasting 
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mechanism will stay the same. 

− When checked, the contrasting color will be derived by flipping the high order bit of each R,G,B 

component of the layer color. For instance, the color that is normally color “1” in the fifteen color table 

(Dark Blue) has R=0, G=0, B=127 (7F hex), so the contrasting color will be R=128, G=128, B=255 (a color 

that is not in the default fifteen color table). 

Some users prefer this mode, although it can be problematic. For instance: a color very close to the Dark 

Blue from above, for instance R=0, G=0, B=128 (80 hex) will contrast to R=128, G=128, B=0, which is quite 

different to the previous contrasting color. 

• “Location and Dimensioning Tool Setup” dialog 

a new mode for the number of digits after the decimal point has been added: “Exact”. When this option is chosen, 

that exact number of digits will appear after the decimal point including any trailing zeros. This is useful when 

the number of digits after the decimal point imply a tolerance for the drawing. The old mode of “Maximum” still 

exists and works the same way – at most that many digits will be generated, but trailing zeros are dropped. 

• “Go/Favorite Positions” 

A new command has been added, “Remove All”, to clear the current list of favorite position (leaves the list 

empty). 

• “Help”: 

 “Check For Updates”: Checks the PentaLogix website and reports if there are newer versions of the software 

available for downloading. 

 “Release Notes”: To read the release notes for the current version. 

• New accelerator keys (shortcut keys): 

 

File/Import/Drill Shift+F2 

File/Import/Guess F4 

View/Toolbars/Navigation Shift+F12 

New features 8.4.50 

• Layer Visibility: 

”View/Visibility/Layer” Two new commands have been added to facilitate turning ON and OFF groups of layers: 

  “Make Visible” - Shift+F10  

  “Make Invisible” - Ctrl+F10 

One can type a list of layer range, such as “2-4, 14, 20-23” and this list can be interpreted as either layer 

numbers or board layer numbers (determined by the “Board Layer” item in the dialog. 

New features 8.4.10 

• Elements Overlapping Cursor 

“View/Info/Elements Overlapping Cursor”: A new command to provide information about elements covering the 

cursor. A list of all the elements (pads, traces etc.) which cover the cursor will be displayed. 

This is useful when investigating pad stacks, as it is difficult to know how many pads there are on top of one 

another. It can also be used in troubleshooting connectivity as one can see the net names of all elements that 

connect at a certain point.  
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New features 8.4: 

• Navigation View 

A navigation view has been added to show an overview of the relative positions of the current view and the 

visible data and to allow quick modifications of the view (“View/Toolbar/Navigation”). The current view is 

represented as a black rectangle and the extents of the visible data are shown as a filled green rectangle. 

As opposed to the other toolbars, the Navigation View is not dockable, as its square nature would cause it to take 

up too large an area of the screen. However its size and position can be modified by the user and it is 

remembered and restored at the next activation of the software.  The input focus can be shifted to the Navigation 

View by clicking on it or by pressing Ctrl+PgUp. While in the Navigation View Ctrl+PgUp will transfer control 

back to the main view.   

The Navigation View window responds to the following user interaction: 

 Left mouse button drag-and-draw: 

 the view will match the user drawn rectangle. 

 Left mouse button click: 

 will center the view at the spot of the click (at the current zoom level). 

 PgUp: 

 zoom up (same as pressing PgUp in the main view). 

 PgDn:  

zoom down (same as pressing PgDn in the main view). 

 Arrow keys:  

pan the view in the direction of the arrow. 

 Home:  

Same as pressing Home in the main view. 

• Wheel Mouse Support 

Added support for navigation with a wheel mouse and support for the middle button of three-button mice: 

 Rolling the wheel 

 zooms in and out. Rolling forward zooms in and backwards zooms out. Each click zooms the same amount 

as a PgUp or PgDn would do. This mode is only active if the scrollbars are off. When the scrollbars are on, 

rolling the wheel will normally scroll up and down. 

 Clicking the wheel  

(or middle-button of a three-button mouse) will pan the image so that the spot where the click happened will 

end up in the center of the screen. This is similar (though not identical) to using the End key. One can pan 

repeatedly in one direction by making sure that the arrow and crosshair cursors are not joined, then moving 

the arrow cursor close to one of the window edges and clicking the wheel repeatedly. 

Notes about setting up the mouse: Mouse button actions and properties can be set up in the Windows Control Panel. 

The wheel is often set up to cause a scrolling action and pressing the wheel (or middle button) is sometimes set 

up to simulate a left button double-click. These are user preference that can be changed if desired. This is how 

these settings interfere with the new features introduced above: 

 Scroll: 

If the wheel is set to scroll (in the Control Panel) and the CAM scrollbars are visible, then moving the wheel 

will scroll vertically rather than zoom. This action was present in older versions of the software as well. Note 

that if the scrollbars are not visible (“View/Scroll Bars”) then the setting in the Control Panel does not matter. 

 Middle Button: 

If the wheel (or middle button) click is set to some other action (other than “Middle Button” or default), the 

panning described above will not work. Instead, pressing the wheel will activate whatever action it has been 

programmed to generate in the Control Panel. 

So, if the new functionality is desired, one must make sure that the mouse is set up as desired in the Windows 

Control Panel. In certain cases (depending on the type of mouse) the action of the buttons can be programmed per 

application, so one could have a particular setting for the CAM software and a different one for other 

applications.  
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•  “Setup/Layers” (F10): 

 By layer or Board Layer:  

These two views of this setup dialog are now available. The first:  

− By Layer  

is the same as the operation of this dialog in previous versions.  

− By Board Layer  

 shows only board layers (one entry per board layer). 

When one changes a setting for an entry in this mode, all layers in that board layer will be changed. For 

instance, changing the color of a board layer will cause the color of all layers in the board layer to be 

changed.  

 Right Click Mouse: 

The context menu (right mouse click) has several new commands. Two commands that previously showed 

up only when clicking on top of the “B Layer” column heading now appear at all times. The new commands 

are 

− “Move Up”,  

− “Move Down”  

The “Move” commands will move (up or down) by one position a sequence of layers starting from the 

layer that one clicks on and continuing with all successive loaded layers (until the next empty layer is 

reached). This is useful (for instance) for making an empty spot to insert a VIA layer. 

− “Insert Selection” 

”Insert Selection” will move a selected layer (or range) to the location where one clicks. Loaded layers in 

the destination range will be moved up to make room for the inserted layers. This command is useful for 

rearranging the order of layers. 

The previously existing commands that now always appear on the context menu are “Renumber board 

layers” and “Order layers by B Layer”.  

• Layers Toolbar 

 context menu (right click). Two menu entries have been added:  

 “Board Layer ON”  

 “Board Layer OFF” 

 These will turn the visibility of a whole board layer ON or OFF that is for all the layers that are part of that 

board layer.  

• Remember Directory for Import 

“Setup/Remember Directory for Import”: If set, the File/Import dialog will open in the directory last used for a 

File/Import operation.  

• Import Files 

 “File/Import” has a new feature: 

 “Drill”: 

 added support for the following Sieb & Meyer format commands: 

M97, M98 (Drill Plain Text),  G84 (Nibble Hole),  G85 (Nibble Slot). 

• Export Files 

“File/Export” has these features: 

  “Drill”: 

− For Excellon format: a new option for exporting Step & Repeat blocks: “R Repeat Blocks”. If checked, 

repeat codes (R#) will be used when possible. If unchecked, repeat codes will not be used and each M02 

block will be output by itself. This is useful for machines that do not support the R codes and to 

minimize the number of M01 (End of Pattern) commands, as there is a limitation of at most 3 nested 

M01s (Excellon spec).  

− for Sieb & Meyer format: support for G84 (Nibble Hole) and G85 (Nibble Slot).  
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• Polygons with Holes 

The ability to replace polygons with holes with a set of polygons without holes. This is useful for many reasons. 

One is that the Gerber syntax for polygons (G36/G37) does not allow specification of certain polygons as being 

holes inside other (containing) polygons. As a result, in order to represent polygons with holes in Gerber one has 

two options: 

1. Make the holes scratch entities (on a separate layer) 

2. Decompose the polygons with holes into a set of polygons without holes (which fit together similar to a 

jigsaw puzzle). 

Method (2) has been added in this release. In appears in two places: 

 “Edit/Edit Selection/Polygons/Decompose Into Strips”: 

Will replace any selected polygons that have holes with a number of horizontal polygonal strips without 

holes, such that the result will represent the exact same copper (same image).  

 New Tab: 

A new tab in the “File/Export/Gerber” Options dialog called “Polygons”: 

It has two choices for exporting polygons with holes: “Put holes in scratch layer” and “Decompose into 

strips”. Note that this does not modify the database itself, it just controls how the polygons are exported. 

Also note that this tab does not appear for exporting MDA Gerber data, as polygons with holes can be 

represented using POIN/POEX D Codes.  

• Custom Shapes - Polygons with Arcs 

 (D Codes of type M) can now contain polygons with arc edges. Previously only polygons with straight edges 

were stored and arcs were replaced with approximating straight edges.  

These types of shapes can be generated from several sources: 

 File import 

  D Codes table/Dimensions/Build Shape: 

 when the frame includes polygons with arcs 

 Tools/Convert Drawn Pads/Global:  

when the convert pads included polygons with arcs Note that if these shapes exist in the data and a binfile is 

saved, a new version of the binfile will be written (version 7) which will not be accepted by older versions of 

the software. 

For exporting Gerber extended variants: The standard Gerber extended does not have a polygon primitive 

with arc edges (for custom shapes). When exported these edges will be replaced with chords. The MDA 

extended Gerber format allows arc edges for the polygon primitives.  

• New Edit Selection Features 

“Edit/Edit Selection” has these new features: 

 “Swell”: 

 a new option has been added - “Transcode all swelled D Codes”. If checked will force all D Codes that are 

swelled to be transcoded even when no unselected elements of that D Code exist. This is useful when 

preserving the integrity of the original D Codes is desired.  

 “Match Two Points”:  

This is a general purpose transformation which combines translation (move), rotation and scaling in one 

step. The user picks two pairs of points. The transformation is done so that the first point in each pair is 

transformed into the second point. 

Note that although all elements in the selection are transformed, the D Codes with which they are drawn are 

not. Because of this, it is most useful for transforming polygons.  

 “Step And Repeat”:  

added the ability to edit and change step-and-repeated data. The procedure is the following: 

(1) Select the step-and-repeated data. 

(2) Do “Edit/Edit Selection/Step And Repeat/One-up”. This will remove the step and repeat from the selected 

data and make the result ordinary data that can be edited and modified. Up to this point all of the above was 

available in previous versions. What we have added is that after “One-up” is done the “Step And Repeat” 
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menu will show the step-and-repeat parameters that have just been removed (counts and displacements) at 

the bottom of the menu (in  a list of up to 5 recent step and repeat parameters). These parameters can later be 

reapplied by just selecting the menu item. 

(3) Edit the one-up data as desired. 

(4) Select the data for which the step-and-repeat needs to be restored, then pick the step-and-repeat 

parameters from the bottom of the “Step And Repeat” menu. 

When step and repeat blocks are nested, this procedure may need to be repeated several times if the data to 

be edited is in some inner step-and-repeat block.  

 “Polygons” 

− “Separate Holes”:  

For all polygons with holes in the selection: remove the holes and add as separate polygons.  

− “Group Holes”: 

 Group all the contours in the selected polygons and attach as holes contours that are included in others. 

A contour is defined as a closed path component of a polygon and could be a container or a hole. 

Note that for polygons that do not overlap a “Separate Holes” followed by a “Group Holes” will 

reconstruct the original polygons. 

−  “Replace With Fill”:  

Selected polygons will be replaced with filled areas using traces of a D Code specified by the user. This 

D Code must be of shape “C”. Note that to achieve the same result in the past, the polygons had to be 

converted to F outlines and then one could use “Tools/Fill Polygons/Solid”.  

• Insert Text Spacing 

Extra Spacing -  items added for extra character and line spacing. Character and line spacing can be increased by 

entering the desired values in the dialog boxes. Use 0 for default spacing.  

• “Go”: 

 “Center Of Selection”:  

moves the cursor to the center of the bounding box of the currently selected elements.  

 Center of Element: 

“Active Element/Center of Closest”.  Similar to “Active Element/Closest” except that the cursor is moved to 

the center of the element. Most useful for polygons. Shortcut is Ctrl+Shift+A.  

• Shortcut keys: 

 Layers greater than 9: 

To make active a layer number larger than 9. It was previously not possible to quickly set active a layer 

number that had more than one digit. Pressing any of the digit keys would make the corresponding layer 

active. 

To set higher numbered layers the Ctrl+Shift modifier has been added. So to set the active layer to 24 and 

should do the following: 

Press Ctrl+Shift, while keeping Ctrl+Shift pressed press 2, then 4, then release Ctr+Shift. This would be 3 

keystrokes. 

Note that this does not save many keystrokes over the already existing way (“Setup/Layer/Active (L)”), 

which would have required: 

L, 2, 4, Enter (4 keystrokes). 

However, some people seem to prefer the new method.  

 Dimensioning Tool: 

For the dimensioning tool (Insert/Dimension): Ctrl overrides the “Extended bars” setting in the setup dialog.  

• View Loaded Data From 0,0 

“View/Zoom/…Include (0,0)” This affects the operation of the “View/Zoom/To Show All” (Home) command. If 

“…Include (0,0)” is set then the origin (coordinates X=0, Y=0) is always included in the data displayed even when 

it is outside the loaded data (this is how to Home command worked until now). Sometimes it is desirable to only 
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display the loaded data, as the origin can be far away from it. The user has now the option to pick the preferred 

mode of operation for this command.  

New features 8.2.5: 

• Auto-Snap to Elements 

 “Go/Closest/Auto-Snap”.  When activated, will cause the cursor to snap to the closest active element before 

certain operations: element insertion, move etc. These are the same operations that cause the cursor to snap to the 

closest grid point when the grid is on. Auto-Snap uses the same criteria as Go/Closest/Align (“A”) except that a 

tolerance is in effect: elements that are farther than the tolerance will not be considered. 

When both the grid is on and Auto-Snap is active, Auto-Snap is tried first. 

One example when this is useful is when inserting traces that need to align with existing traces or pads.  

• Dimension Tool: 

“Insert/Dimension” 

New dimensioning tool (similar to the “Insert/Location” tool). 

Will insert dimensioning text and arrows. It is a three-step operation: 

(1) Pick the point to measure from 

(2) Pick the point to measure to 

(3) Pick the desired location of the dimensioning text, arrows and bars 

There is a separate setup dialog (Insert/Loc and Dim Setup) for specifying the text size and font as well as various 

options. This dialog is common to this and the Insert/Location tools. It can also be activated using a context menu 

(right click) while any of these two tools is active. The options that are specific to the dimensioning tool are: 

 Forcing Measurements  

to always be horizontal or vertical (depending on whether the vector from step (1) to step (2) is closer to the 

horizontal or vertical). Note that this setting can be temporarily overridden by pressing the Shift key while 

picking point (3). 

 Extending the Bars  

to reach close to the step (1) and (2) points. 

• ”Edit/Edit Selection/Polygons” 

 “Make Well Formed”: 

Replaces any malformed polygons in the selection with well formed ones. Well formed polygons have no 

intersecting edges (except at vertices) and no overlapping edges. 

 “Chords To Arcs”: 

Approximates sequences of chords with arcs for polygons in the selection. The user can specify a tolerance. 

The new selection will consist of the changed polygons. If none were changed, the selection remains as 

before.  

 “Arcs To Chords”: 

Replaces arcs with sequences of chords that approximate them. The resulting polygons will contain no arcs. 

The new selection will consist of the changed polygons. If none were changed, the selection remains as 

before.  

New features 8.1: 

• Save File Crtl+S 

Normal Windows shortcut for File/Save (Ctrl+S) has finally been implemented. We had postponed the 

implementation of this shortcut because Ctrl+S used to have a different meaning in our DOS products.  

• BMP File Export 

“File/Print to .bmp File”: a way to generate standard Windows bitmap files from the currently loaded data; either 
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the current view or what is inside the frame. The image can be combined layers or one board layer at a time (with 

one .bmp file per board layer). Besides other uses, this can be another way of printing in cases where direct 

printing (to printer) does not produce the desired results. 

•  “File/Import”: 

 Inexact Arcs: 

“Gerber/Options”: added an option in the “File Interpretation” tab called “Inexact arcs”. This controls how 

inexact arcs (arcs that have different radii at the two endpoints) are interpreted. One can pick one of two 

ways to deal with these arcs (as they are illegal as presented): 

−  “Move center”  

If selected then the center of the arc will be moved to make the two radii the same. This is sometimes 

dangerous as the guessing for the arc orientation can be wrong resulting in “Mickey Mouse ears” (large 

multi-quadrant arcs where short single-quadrant arcs were intended by the user). 

− “Add connector” 

If selected then the center is preserved and one of the arc endpoints is moved to be closer to the center. A 

connecting linear “bridge” is added to go to the original endpoint (so that electrical connectivity is not 

lost). This would cause an arc to be replaced by an arc and a (short) linear trace.  

 Ignore G92/93: 

Added an option called “Ignore Excellon G92/G93” in “Drill/Options”. When set causes G92 and G93 

commands to be ignored. These are “Zero set” commands that change the origin. 

• DRC Violation Colors 

DRC violation errors display colors are now saved in the .cfg file.  

• Define Report Filename 

 “File/Report/Set Name”: to set the report file name. The report file is used in many operations where the name 

cannot be set, such as for generating D Code transcoding reports while importing Gerber files.  

New features 8.0.X: 

• Import Gerber via File/Open 

One can now import Gerber files using the File/Open dialog. This has the additional benefit that one can associate 

a common Gerber file extension (such as .ger) with these executables, so that double-clicking on that file would 

launch the executable. The .bin extension is automatically associated with the PentaLogix CAM products 

(excluding ViewMate).   

To create the association: right click on the desired file and select “Open With”, then choose the executable.   One 

more step is needed to make sure that path names that have spaces in them are handled correctly.  Open 

Explorer, then “View/Folder Options/File Types”.   

Pick the type you just added and click on Edit, then “open”, “Edit”. In the "Application used to perform action", 

add “%1” after the name of the executable. The double quotes around %1 are needed to make sure that the entire 

path name is passed to the executable.  

• “File/Import Enhancements” 

 “Gerber”:  

− Mirror Image: 

Support for “MI” (mirror image) RS-274X parameter. 

− Padstacking: 

A new option in “Options/File Interpretation”. “Consecutive flashes at same position”. This has two 

options: “Keep only one” and “Keep all”. The previous versions would always “Keep only one”, but 

apparently some users need these padstacks preserved. 
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• Drill Import Options 

“Setup/Layers” (F10): added a button to bring up the drill import options.  

• Goto Favorite Position 

 “Go/Favorite Positions”: a quick way to go to a favorite (X, Y, Zoom) triplet that one can previously record.  

• Gerber IPNEG Followed by IPD or IPC 

For both import and export of Gerber Extended files: a new option in the “RS274-X Options” tab. The option is 

“Negative layer is IPNEG followed by:” and the two possibilities are “LPD” and “LPC”. It appears that various 

plotters and CAM packages expect different commands to render a negative layer: either “IPNEG” followed by 

“IPD” or “IPNEG” followed by “IPC”. As usual, the Gerber manual is no help, as it does not elaborate as to what 

the correct combination should be, so we decided to let the user pick one or the other (separate for import and for 

export). Previously “IPNEG” followed by “IPD” was the only interpretation.  

• MDA Output – Unique Layer Names 

“File/Export/MDA Autoplot/Options/MDA Options”: a new checkbox called “Force unique layer names”. This is 

only relevant when “Merge paint and scratch “ is also checked and will append “.L<layer_number>” to each layer 

name to insure that the individual files generated have distinct names.  

• Select Invalid Polygons 

A new selection criterion in the “Special selection” droplist called “Invalid Polygons”. This will select polygons 

that are invalid as far as the PentaLogix CAM software is concerned (for instance self-intersecting polygons are 

invalid). The intention is to replace this command in the future with one that can “fix” the invalid polygons. 

• Handling of negative and scratch layers 

Layers that were set as both negative and scratch (NS) were handled differently in the contour methods versus 

the raster methods. A unified way of handling them has been implemented following the rules below: 

 A scratch layer cannot be the first layer in a board layer.  

Such a situation will be flagged as an error during processing of connectivity information. We have 

sometimes seen the first layer set to both negative and scratch. If the user’s intention was to have it as a paint 

layer then both the scratch and negative settings should be removed. If the user’s intention was to have it as 

negative, then the scratch setting should be removed. 

 If an NS layer follows a negative layer  

(N = Negative set, but not Scratch), then the NS elements will be scratched from the N elements and then the 

whole image will be inverted (to make it negative) 

 If an NS layer follows a non-negative layer 

(P=Negative not set), then the NS layer will be first inverted (to make it Negative) and then the result will 

scratch P. This will make an NS following a P act as scratching everything except where there are elements of 

NS.   

This will affect Raster and Contour netlist as well as Raster and Contour DRC as well as AOI tools.  

• Loading 10,000 D-Codes 

All possible D Codes (10000) can be loaded at the same time (previously there was a limit of 2000 simultaneously 

loaded D Codes).  

• 255 Layers 

The number of layers has been increased from 99 to 255.  

• Negative and Scratch Rendering 

The rendering (display on screen) of negative and scratch layers has been improved. For the case of negative 

layers: when more than one negative layer existed the rendering was sometimes incorrect in the past, since it did 

just one negative operation on the merged negative layers.  For scratch layers: they will automatically be 
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displayed in the color of the immediately preceding paint layer, so that manually setting the layer color to match 

is no longer necessary.  

• “File/Import”: 

 “HPGL”:  

“PG” command (“Advance Full Page”) will cause step to next layer. Previously it was ignored.  

• Distant Measurement Handles All Types 

“View/Distance/From Edge”: distance measurement tool from edges of elements now handles all element types. 

Previously it only handled linear traces and certain pads (of simple shapes).  

• Sum of all trace lengths 

“View/Selection/Properties”: a new item has been added – “Sum of all trace lengths”. This will appear when 

traces are part of the selection. When nets are made of chains of head-to-head traces, this will also be a good 

approximation for the length of the part of the net that is selected.  

• “Setup/Layers” (F10):  

 Paths: 

The “Path” button has been expanded to give a choice of 3 operations:  

− Strip path  

− Make relative to current directory 

− Fill in full path.  

• Viewing Text Files 

The application used to view text files (such as by File/Report/View) used to be “notepad.exe”. It has now been 

changed to use any application that the user registered for opening a “Text Document” (.txt extension). This is 

usually done with “Explorer/View/Folder Options/File Types”.  
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Changed Features 

Changed features 9.2.21: 

• “Layers Toolbar” 

When a layer contained only scratch elements inside (although the layer as a whole could be marked as paint) it 

was difficult to figure out what was going on, as the layer would be invisible when viewed by itself. Now, layers 

of this kind are marked with a “+” (instead of the “*”) to draw attention that something unusual is going on. Then 

the right click context menu command “Paint And Scratch/Force Inner Polarity To Paint” (which replaces 

“Separate Layer…” in this case) will make all the inside elements paint and also flip the polarity of the whole 

layer (if it was paint it becomes scratch and vice versa). At this stage, the data is equivalent to what was there 

before, but now the polarity can be easily manipulated (via the “Scratch” checkmark).   

• Mouse Wheel Behavior 

Moving the mouse wheel scrolled up and down when the scrollbars were visible and zoomed in and out 

otherwise. The behavior when the scrollbars are off is unchanged. However when the scrollbars are on, moving 

the wheel will scroll up and down when no other key is pressed, scroll left and right when the Shift key is pressed 

and zoom in and out when the Ctrl key is pressed. 

Changed features 9.2: 

• “Layers Toolbar” 

Two buttons have been added to facilitate access to two frequently used commands from  

“View/Visibility/Layer”: “Next Layer” (Shift+Equals) and “Previous Layer” (Shift+Backspace). 

•  “File/Import”: 

 “ODB++”: One can now import Valor ODB files in Viewmate. 

 “Excellon”: Files with ‘T’ codes that also have ‘F’eed or ‘S’peed or ‘C' (diameter) commands on the same line 

will be recognized as Excellon. 

 “Apertures”: TraxMaker apertures are now supported using the same algorithms as Protel.  

  “Guess”:  

− Gerber files that use CR/LF as a block delimiter.  Dialog boxes now have radio buttons for Asterisk or 

CR/LF block delimiters. 

− G70/71 (inch/mm) will be recognized in extended Gerber files.  

− Will now gray out parameters defined in files so that the user cannot change things like the Inch/MM.   

− Will grey out Quadrant and 360 arc buttons only if G74/ G75 have been found, and G74/ G75 appear in 

the file before the arc commands (G02/ G03). 

− Excellon files in inch will be set to 2,4 but won’t be greyed out in the view format dialogs.   

− When “Format unknown files to known files” is checked in the options box; if the unknown file had m,n 

or in/metric defined, the algorithm will not change those values. 

•  “File/Print” 

A new item has been added for the “Content” box: “Visible layers (combined)”. This will print on one page all 

visible layers. 
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• “Edit/Edit Selection” 

Because of new commands that needed to be added to this submenu (see “Replace M-Type Pads With 

Primitives”) and to prevent this submenu becoming too long, it has been slightly reorganized. A new submenu 

“Special” has been added, which contains the above mentioned new command as well as “Match Two Points” 

and commands that used to be in the “Arcs” submenu. These commands are likely to be used less often, so they 

are separated in this submenu.  

• “Swell” 

 speed has been improved, especially for swelling large polygons. 

• “Polygons”: 

“Make Well Formed” and “Chords To Arcs”: More accurate results are computed. 

• “Setup/Layers” 

The height of the rows in the layers dialogs is now remembered and restored. The height can be adjusted by 

moving the cursor to the border of two rows, waiting for the cursor shape to change, then dragging the border to 

the desired position. 

• Visibility Toolbar 

A new button has been added for the visibility of polygons. A group of four buttons have been added to control 

how the selected elements are displayed (two of these modes are new in this version, see below). 

• Insert Toolbar 

A new button has been added for the new “Insert Chamfer” tool. 

Changed features 9.0.50: 

• “File/Save Options” 

The two options: “Include Net Info” and “Step And Repeat Blocks” have been moved to a new dialog: 

“Preferences”. This dialog also has a new item, the desired version number of the jobfile (.bin file). 

With newer versions of the CAM software, as more features were added, the jobfile format needed to be updated. 

The current version of the jobfile format is 9, but it is in general not directly related to the version number of the 

software. Older versions of the software can of course not read these new jobfiles, so the option has now been 

added to save older version jobfiles when needed. 

When a user chooses for output an older version jobfiles and the job contains elements and features that cannot be 

represented in that version, those elements will be dropped or converted (if possible). The user will be prompted 

before the output. 

For a short history of jobfile version numbers press the “Info” button in the “Preferences” dialog.  This feature is 

especially useful when saving files for the Pulsar photoplotters.  The Pulsars cannot accept files newer than 

version 6. 

• “File/Export/Cutter Code (HPGL)” 

There is now an “Options” dialog that allows specification of whether to output pads and the manner in which 

they are output. There are three choices: pads are not output, they are output as a “Pen Down” or they are output 

as a small circle. Previously pads where always ignored. 

• “File/Import/Guess or Zip or Directory” 

 Filenames with the extension of “.err” will be ignored.  Files that have import parameters defined in the file, will 

be displayed with those parameters grayed out (cannot be changed). 
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Changed features 9.0: 

• “View”: 

 “Toolbars/Editing”: the “Delete” button has been moved to the end of the toolbar.  Some users have 

complained that it was too easy to press it by mistake.  

• “Edit/Edit Selection/Swell” 

previously, if N-type D Codes were in the selection, an error message was displayed and the swell was not done. 

Now, N-type D Codes in the selection can be swelled, but only if all of the D Codes of that tool number are in the 

selection (otherwise a transcoding of the tool number would be necessary and this is currently not supported). 

• “Insert”: 

 “Text”: the font of the dialog has been changed to Courier, which is a fixed width font. This facilitates 

entering tabular data into the “Text” box (columnar text where the columns need to line up). Note that for 

this to work the chosen CAM software font should also be of fixed width (one of: DMPL, Uppercase, ODB, 

4X7 or 5X7). 

 “Location”: the coordinates that are inserted will be relative to the “Relative Origin” when in “Relative” 

mode. 

Changed features 8.4.50 

• High Resolution Only 

“File/Save Options”: The “High Resolution” option has been removed. Binfiles are now always saved in high 

resolution. Low resolution is only needed for versions 6.0 or earlier of the CAM software. 

• Scroll Bars Changed 

“View/Scroll Bars”: the scroll bars now scroll over the loaded data rather than over a user defined workspace 

(“Setup/Preferences/Workspace”). For instance: moving the horizontal scroll bar to the leftmost position will 

place the view over the left margin of the loaded data. 

Changed features 8.4 

• Changes to Printing Routines: 

“File/Print”: The graphics rendering routines for printing have been changed. Windows GDI routines are now 

used instead of rendering to a bitmap and then sending the bitmap to the printer (as was done previously).  As a 

result, printing should now work for all printers. Previously some printers did not work properly because of 

memory limitations (the bitmaps were too large) or raster operation limitations.   

This change should also allow capturing the image in a PDF file (with Adobe Acrobat Distiller) or a PostScript 

file.   

Note: This new method does not work on Windows 98 or ME, in which case the old method (bitmap based) will 

still be used. It does work on Windows NT, 2000, XP, 2003 Server. 

The color output options have been reduced to two: “black on white” and “colors on white”. Note that colors will 

not be translucent when printed (this is different from how the colors show on the computer screen).  When 

running under Win98 or ME an additional checkbox is shown called (“Negative”) which will cause the bits in a 

“black on white” output to be inverted (this is needed on some printers).  

• “File/Import”: 

 “Job”: “Options”:  

Origin selection has been removed. Origin is now always at (0,0). Allowing to set the import origin in a sub-

dialog was confusing and dangerous. The imported data can always be moved later if that is desired. 

  “Gerber”: 
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− The user is warned if a self-intersecting polygon is encountered in the input.  

− The "Full circles in polygons" settings has been removed from “Options/File Interpretation”. The 

“Ignore” choice caused full circles to be silently ignored, which was a problem for many users.  

 “Aperture Wizard”:  

A new checkbox has been added in the third menu titled “Treat commas as decimal ex: 1,00 = 1.00” This will 

allow the  aperture wizard to import files using the European style of decimal identifiers. 

• Setup Layer Improvements 

 “Setup/Layers” (F10): Position and size of the dialog as well as the widths of columns in the table are now saved 

in the registry and restored next time the program is started. Note that the width of the columns can be modified 

by the user by dragging the column separators.  

• Replicate to Non-Contiguous Layers 

In the Layers Toolbar; layers can now be replicated to a number of layers that need not be contiguous. Previously 

only a range of contiguous layers was allowed as the destination.  

• “Edit”: 

 Chords to Arcs: 

“Edit Selection/Polygons/Chords To Arcs”; improved detection of arcs.  

 Transcoding: 

“Edit Selection/Transcode”; The “First Unused” option has been changed to “First Unmapped”. This will 

pick the first D Code that is either not present in the D Code table or has shape of type “?” (unspecified).  

 Aligning Layers: 

“Move Layers/Align”; the guide element needs to be selected and to be the only selected element. Previously 

the guide element was the one from the last “element align with properties” (Shift+A) operation. The new 

method makes the identity of the guide element clearer.   

Also, previously the guide element was only matched against elements of the same D Code. There is now a 

new setup command “Move Layers/Align Method” that allows the user to pick the method to be used: same 

D Code (as before), same shape type and same shape (shape type and shape dimensions).  

• TEXT is now Grouped 

The internal representation of text has been changed.   

In previous versions text was stored as a sequence of strokes (traces or pads) which were not distinguishable from 

other (non-text) traces and pads. With this new implementation text is a separate entity (a composite element) so 

that it can be modified later (by editing the text string, changing the font, rotation etc.) This modification can be 

done with “Edit/Edit Selection/Text/Change” after selecting one (or more) text blocks. When selecting only one 

text block, all parameters of the text (including the text string) can be changed. When more than one text block is 

selected, only parameters that have the same value can be changed (the others are grayed out). An exception to 

this rule is the font, which can be changed even if the selected blocks have different fonts.   

Note that there are other methods to change parameters that are not common to all blocks. For instance one can 

change the D Code of a group of text blocks by using “Edit/Edit Selection/Transcode” (as one would for other 

elements).   

One can ungroup text by using “Edit/Edit Selection/Text/Ungroup”. This will transform the selected text blocks 

into their stroke representation (normal traces or pads).  

• Select Text 

The Selection Toolbar criterion dropbox has a new added item called “Text” which can be used to select or 

navigate over text blocks.  Text blocks can only be edited with operations that would result in another text block. 

So, for instance, moving, rotating and mirroring are allowed, whereas scaling can preserve text blocks only if the 

two scale factors (X and Y) are the same. If there are not the same, scaling will be done but the text will be 

ungrouped before the scaling operation.   

For other commands, if one finds that they do not affect text blocks in the desired fashion the workaround is to 
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ungroup the text blocks first.   

Text blocks will be ignored by most of the commands under “Tools”, except Netlist, DRC and “Generate 

Soldermask”. Note that for netlist extraction the copper of text blocks is taken into consideration when computing 

connectivity (of other circuit elements), but no net numbers are ever assigned to text blocks.   

Binfiles that contain blocked text will not be readable by older versions of the CAM software. If you need to send 

such data to users of older versions make sure to unblock all text blocks before saving the binfile.  

•  “Insert/Loc and Dim Setup” 

a new parameter has been added: “Max digits to the right of decimal”. This can be used to control the precision of 

the inserted text for location or dimension. Possible values are from 0 to 6 inclusive.  

•  “Tools” 

“Design Rules Check/Load Errors from File”:  

More than one file can be loaded at the same time (with the same load operation). This allows the display of the 

contents of several files simultaneously. One example where this would be useful is for viewing together the 

results of several different DRC operations done with per layer rules.  

Changed features 8.2.5 

• “Edit/Insert”: 

 Menu Location Has Moved: 

The position of the menu  has been move to “Insert” (top-level menu), because this is a very commonly used 

submenu. Note that the shortcut key (Insert) still works even with the new location. 

 Insert: 

When inserting a trace-type (linear or arc), the outline of the shape to be inserted will be displayed around 

the cursor as a guide to the user.  

• Setup Selected Tools: 

A new group has been added: Setup/Tool Codes (Shift+F5) with two buttons:  

 “Type + Diameter”  

Same as double clicking on the selected tools and will set the type and diameter of the selected tools. 

 “Type Only”  

Sets only the type of the selected tools, keeping their diameters.  

• Extended Gerber Parsing 

Changed to where LP (layer polarity) commands do not reset pending G36 (polygon area fill) commands. We 

have seen customer files of the form: 
G36*%LPD*%X-1757Y13D02*…G37* 

Previously the LPD command would reset the G36 and the polygon would be lost (replaced with outline traces). 

• Transcoding D Codes 

“Edit/Edit Selection/Transcode” (Ctrl+T): When the user is prompted for the D Code to transcode to, a choice is 

given between the current D Code and the first unused. Previously only the first unused would appear. Some 

users preferred the current D Code as they have just set it up in the D Code table in preparation for the Transcode 

operation. 

Changed features 8.1 

• Screen Toolbar Display Boxes Widened 

Widened X and Y coordinate display boxes in Screen Toolbar to allow the display of all the digits. 
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• Individual User’s Preferences 

The product configuration files (*.cfg, for instance CAMMaster.cfg) are now stored in a different directory to 

facilitate per user configurations. They used to be stored in “Windows directory” (normally C:\Windows). Now, 

if the environment variable “HOMEPATH” is defined, that directory will be used instead. This variable is 

automatically set in certain versions of Windows, such as XP, but can be set by the user otherwise. 

If you want to preserve you’re your old settings, please move the .cfg file to the HOMEPATH directory. To 

determine the setting of HOMEPATH or to set it to a different directory, use “set” from the command prompt.  

• Move to Cursor has Independent Relative/Absolute Mode 

In the “Move Cursor To” dialog, the type of move (Absolute, Relative, Incremental) is now set separately 

depending on the coordinate display mode (Absolute, Relative), that is once set in Absolute display mode it will 

stay the same even if changed while the display mode is Relative. The two settings will be remembered 

independently. 

• Report Files List Both Import and Export Formats 

The report file will now separately list the Gerber import and export formats, as well as the Drill import and 

export formats. Previously only the import formats were reported.  

• Custom Apertures with Polygons 

“Setup/D Codes” (F5): “Custom Apertures/Replace With Primitives”: primitives that are polygons will now 

generate polygons rather than F-type outlines.  
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Bugs Fixed 

11.24.27 

• Import DXF 

• Import ODB++ bug 

11.22.32 

• Tango Aperture Import 

• Incorrect rendering of small polygons at certain zoom levels 

• Import ODB++ 

s_ths iimport problem. 

11.22.2 

• D Code mirror 

Failed on rotated D Codes. 

11.20.29 

• Gerber X2 import 

TO and TD directives misinterpreted. 

11.20.22 

• Import > Directory 

Failed on certain data 

11.20.16 

• Import ODB++ 

Some step-and-repeated ODB files were imported incorrectly. 

• Import DXF 

Some arc edges were imported as straight. 

11.20.7 

• Import ODB 

Some component files were imported incorrectly. 

11.20.4 

• Import ODB 

Some component files were imported incorrectly. 
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• Bugs in Import IPC-2581 fixed 

11.18.49 

• Import DXF 

Some files with splines were imported incorrectly. 

11.18.40 

• Move (Shift+M) Reference Frame Disappears When Zooming 

11.18.37 

• Setting Max Undo Memory 

11.18.19 

• Fixed ODB Import Crash and Bugs 

• Some Gerber X2 Layer Types were Misinterpreted 
Copper layers. 

11.16.59 

• Restored Windows 7 Compatibility 

11.16.53 

• Import ODB++ 

Some polygons were imported incorrectly. 

• Import 

Drill files with lines ending with CR only (no LF) were not recognized correctly. 

• File Open Dialog 

Allowed only one item to be picked. 

11.16.42 

• Crash in import ODB 

With new import module when components were missing outlines. 

• Printing 

With certain settings, printing component layers (CMU/CML) caused a crash. 

11.16.37 

• Printing 

One extra page was printed. 
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• Undo 

In certain cases, for layers containing paint and scratch, an Undo did not restore the proper paint/scratch order 

resulting in covered elements. 

• Import ODB++ 

ODB++ data that contained the “features” file inside a folder called “features” was imported without data from 

those files. 

Using the new import module (not legacy) pads in drill layers were mapped to C instead of N. 

Net import and data import failed on certain files. 

• Print to SVG 

Incorrect data was output. 

11.16.1 

• Import Directory 

On some Gerber files coordinate values were computed incorrectly. 

11.14.60 

• ODB Import Crash 

11.14.52 

• Drag and Drop 

For dropping files on the view or layers toolbar. On some versions of Windows this stopped working. 

11.14.45 

• Drag and Drop 

Did not work in certain situations. 

• Rotate and Mirror 

When choosing the cursor as a reference point the operation generated an incorrect result. 

11.14.41 

• Using Two Monitors 

When the main screen was positioned on the second monitor, it would not restore correctly when the software 

was started again. 

11.14.35 

• Copy-Paste 

When copying elements from one instance of the CAM software into another one, the layer info was also copied. 

This is usually not desirable. The layer info is now not copied. 
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11.14.14 

• Import ODB++ 

Fixed problems. 

• Changing units 

When switching units between metric and English, some arcs were displaced. 

11.14.7 

• Import ODB++ 

Fixed crash when importing certain files. 

Some rotated elements were imported incorrectly. 

• Import DXF 

Some text was placed at the wrong location. 

• Import Drill Files 

Some files with tool numbers larger than 255 caused a crash. 

11.12.51 

• Import Excellon drill files 

Some metric drill files were imported incorrectly. 

11.12.48 

• Import Excellon drill files 

Some nested step-and-repeat blocks were imported incorrectly. 

11.12.46 

• Trim Selected Traces 
“Edit/Time Selected Traces” generated incorrect results for some pairs of arcs. 

• 3D View 

Board outline was sometime computed incorrectly. 

Image areas that extended into the board outline were not displayed. 

Viewer was not working on computers that had culture set to other than English. 

Soldermask layers were not included in the 3D view 

11.12.34 

• Spurrious Undefined D Code Messages 

When importing Gerber files. 

11.12.32 

• Polygon Swelling 

Caused crashes for certain polyons. 
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11.12.28 

• GerberX Import 

Some custom apertures were imported incorrectly 

• ODB Import 

Text that included mirroring was sometime placed at the wrong location 

• Import Excellon Drill Files 

For certain files, the tool type (plated / unplated) was imported incorrectly. 

11.12.23 

• ODB Import Generated Incorrect Aperture Dimensions 

11.12.22 

• Import Excellon Drill Files 

For certain files, the tool type (plated / unplated) was imported incorrectly. 

11.12.9 

• Import Gerber Polygons 

Corrections on some polygins with cut-ins generated incorrect results. 

11.12.6 

• Temporarr files cleanup 

Temporary files generated during import ODB++ were not removed after the import completed. 

11.10.79 

• Sieb & Meyer Import Tool Numbers Larger than 255 

The tool change command was silently ignored. 

11.10.73 

• Import Gerber 

Gerber 274-X files that had macro apertures (AM) with arithmetic expressions where multiplication was 

represented with lower case “x” did not import correctly. Upper case “X” was expected. 

• Import Barco DPF 

Certain rotated shapes were imported incorrectly. 

11.10.58 

• ODB++ import bugs fixed. 
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11.10.24 

• Crashes while importing ODB++ 

• When importing a job (.bin file) with step and repeated routing paths, the step and repeat info was lost. 

11.10.5 

• ODB++ import bug 

Some jobs with rotated apertures were impoirted incorrectly. 

• Transcoding during Import Job 

Some NC tool parameters were not transcoded correctly. 

11.8.14 

• When multiple NC drill or rout files were imported together, sometimes conflicting tool numbers were not 

trasncoded correctly. 
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Release History 
NOTE: this is only a partial list. Not all released versions are shown. 

 

Version Release Date 

11.24.2 Mar 1, 2024 

11.22.1 Feb 2, 2023 

11.20.1 Nov 12, 2021 

11.18.1 Sep 18, 2020 

11.16.42 Jan 6, 2020 

11.16.1 Jun 11, 2019 

11.14.1 Jun 7, 2018 

11.12.51 Feb 3, 2018 

11.12.32 Sep 3, 2017 

11.12.6 Feb 19, 2017 

11.10.79 Nov 15, 2016 

11.10.1 May 14, 2015 

11.8.1 Feb 11, 2015 

11.6.35 Sep 28, 2014 

11.6.0 Aug 14, 2013 

11.4.45 Jun 8, 2013 

11.4.29 Dec 2, 2012 

11.4.6 Apr 26, 2012 

11.4.0 Feb 14, 2012 

11.2.78 Dec 1, 2011 

11.2.47 Mar 18, 2011 

11.2.1 Sep 10, 2010 

11.0.80 Aug 1, 2010 

11.0.9 Jan 21, 2010 

11.0.1 Nov 1, 2009 

10.6.71 Sep 28, 2009 
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10.4.31 Mar 17, 2009 
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10.2.0 Oct 3, 2008 

10.0.30 May 30, 2008 

10.0.1 Mar 17, 2008 

9.8.70 Dec 31, 2007 

9.8.0 Sep 10, 2007 

9.6.91 May 31, 2007 

9.6 Jan 2, 2007 

9.4.73 Jun 22, 2006 

9.4.1 Mar 3, 2006 

9.2.41 Jun 30, 2005 

9.2 Apr 5, 2005 

9.0 Aug 5, 2004 

8.4.50 Dec 17, 2003 

8.4 Oct 27, 2003 

8.2.5 Feb 26, 2003 

8.1 Oct 23, 2002 
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